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Overview
Metadefender Kiosk helps protect your network by enabling control over the flow of data into
and out of your organization. It can be used as a media scanning station on your own hardware
or on OPSWAT's custom-made kiosks. Typically, media such as USB devices, DVDs, card
readers, SD cards, flash drives, or floppy disks, are scanned by Metadefender Kiosk by
inserting the media device into the appropriate drive. After the scan is complete, Kiosk
generates a detailed report.

Data Diode Use Case

This user guide covers installing, configuring, upgrading, using, and troubleshooting
Metadefender Kiosk.

4.1.0
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Key Features
Protection against zero-day attacks (Metadefender Core integration).
Customized data security policies.
Control over data flow.
System restore.
Active Directory authentication.
Custom Authentication.
Portable Media including floppy disks, SD cards, CDs, DVDs, encrypted USB and disc,
and more.
UI localization/internalization (comes with English, Arabic, Hebrew, Japanese, Korean
and the ability to manually add any other language).
Securely wipe USB drives.
Easier system hardening.
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User authentication
Metadefender Kiosk has the following authentication features:
Active Directory authentication
Supports custom authentication
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Peripheral media
Metadefender Kiosk automatically detects multiple peripheral media insertions for the following
media types:
USB devices*
CDs/DVDs/Blu-ray
Card readers
SD cards
Floppy disks
* Not all USB devices are currently supported. If you have a specific device you need
supported, please contact OPSWAT support.

4.1.0
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Encrypted USB devices
Metadefender Kiosk can unlock encrypted USB devices with a given password. Metadefender
Kiosk supports the following encrypted USB devices:
Biocryptodisk-ISPX
Buffalo RUF2-HSCT and RUF3-HSL
IronKey S200
IronKey S1000
IronKey D250
IronKey D300
Kanguru Defender Elite 30
Kanguru 2000 and 3000
Kingston DataTraveler 2000
Kingston DataTraveler Vault Privacy
Kingston DataTraveler Vault Privacy 3.0
Kingston DataTraveler 4000 G2 (Managed)
SanDisk Cruzer Enterprise FIPS Edition
SanDisk Cruzer Contour
U3 based USBs
EncryptDisc CDs/DVDs
Microsoft BitLocker: Metadefender Kiosk supports BitLocker To Go using passwords.
Metadefender Kiosk does not support BitLocker encryption using key files, smart cards,
or VHD (Virtual Hard Drive) BitLocker encryptions.
McAfee Complete Data Protection when McAfee file and Removable Media Protection
client is installed
USB Flash Security

4.1.0
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Media handling
Metadefender Kiosk's media handling features include the following:
Can scan drives with multiple partitions
Can perform a full or partial media scan
Can wipe/format USB drives
Supports integration with Metadefender SFT ( Secure File Transfer) for accessing and
downloading scanned files
USB device soft eject
CD/DVD eject

4.1.0
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Processing files
Metadefender Kiosk uses Metadefender Core to process files. Metadefender Core has the
following processing features:
Scanning with multiple anti-malware engines
Data sanitization
Application vulnerability detection
Heuristics for zero-day threats
Archive extraction
File type verification
Workflow engines

4.1.0
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Scanning session results
After scanning media, Metadefender Kiosk allows you to view detailed scan logs, and print
scan results.

4.1.0
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Customizable interface
The Metadefender Kiosk interface includes English, Arabic, Hebrew, Japanese, Korean,
German, and Vietnamese translations and supports the addition of other languages.

4.1.0
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System hardening
Metadefender Kiosk comes with a variety of system hardening features for maximum security.
Disabled autorun
Users can only exit by pressing ALT+F4 and, if Kiosk is configured to require a password
to exit, entering the admin password
Blocks the ability to copy files to the system
Blocks the ability to execute files on the system
Runs automatically on system startup
Configurable file policy by file type
Select allowed/blocked and skipped files by file type and size
Select file extensions to be taken under consideration when a file type mismatch is
performed

4.1.0
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1. Installing / Upgrading Metadefender Kiosk
Before you begin the installation, you should ensure that system requirements are met. You
can install Metadefender Kiosk by either using the embedded Install Wizard or from the
Windows command line.
Once you finish installing Kiosk and Harden the kiosk, you can deploy and launch the kiosk UI
for usage.

This section does not cover installation of Metadefender SFT and Metadefender Core.
Refer to the user guides for them.

1.1. Kiosk System Requirements
Hardware requirements
When Metadefender Kiosk is installed on a separate machine than Metadefender Core, the
machine Metadefender Kiosk is installed on must meet the following requirements:
Minimum system memory: 4 GB
Minimum available hard drive space: 10 GB
Minimum CPU architecture: 2 cores, 2 GHz clock rate
When Metadefender Kiosk is installed on the same machine as Metadefender Core, refer to the
Metadefender Core user guide for additional system requirements.

Software requirements
Metadefender Kiosk can only process files on devices with Windows file systems. It does not
detect Linux or Macintosh file systems.
Operating System - Windows 7 / 8 / 8.1 / 10 / 2008 R2 / 2012 / 2012 R2 / 2016
Bitness - 64bit only
Windows Installer - 4.5 or higher

4.1.0

20

OPSWAT Metadefender Core® - In order to scan files with Metadefender Core's multiscanning capabilities, Metadefender Kiosk requires a Metadefender Core server. You
can install the Metadefender Core server on the same machine as Metadefender Kiosk,
or on a separate machine that Metadefender Kiosk can access over the network. The
requirements for Metadefender Core vary depending on which version you plan to use.
Metadefender Kiosk version 4.1.0 and later require Metadefender Core version 4.8.1 or
later. Refer to the Metadefender Core Product Documentation for Metadefender Core
installation instructions.

Installed third party components
The following third party components are installed as part of the Metadefender Kiosk
installation process. These components may be shared with other applications.
All of these are required by Metadefender Kiosk. Uninstalling them may result in unexpected
behavior of other applications.
Component

Details

IIS express

IIS express 8.0

.NET framework

4 Client Profile
Extended

Microsoft Visual C++
redistributable

Microsoft Visual C++ 2005 Redistributable
Microsoft Visual C++ 2008 Redistributable
Microsoft Visual C++ 2008 Redistributable - x86
Microsoft Visual C++ 2008 Redistributable - x64
Microsoft Visual C++ 2010 Redistributable - x86
Microsoft Visual C++ 2012 Redistributable - x86
Microsoft Visual C++ 2012 Redistributable - x64
Microsoft Visual C++ 2013 Redistributable - x86
Microsoft Visual C++ 2013 Redistributable - x64

MongoDB

4.1.0

An open source database that uses a document-oriented
data mode
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Installed Windows services
The following Windows services are installed as part of the Metadefender Kiosk installation
process.
Metadefender Kiosk REST
Metadefender Kiosk

Ports that need to be available
The following ports need to be available for the machine Metadefender Kiosk is installed on.
Component/service

Port

Metadefender REST

8009

MongoDB

27019

Application directory and registry key
Installation location
You can choose the installation location for Metadefender Kiosk.

Application directory
The %PROGRAMDATA%\OPSWAT directory is used for storing Metadefender application
data. It also stores the license file.

Registry key
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\OPSWAT is the registry key for all
OPSWAT products.

Temporary directory used for processing files
When processing files, Metadefender Core uses the temporary directory (c:\windows\temp).

4.1.0
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Antivirus whitelist requirements
If you are running an anti-malware agent with real time protection on the Metadefender Kiosk
system you must whitelist processes running out of the Metadefender Kiosk installation
directory. OPSWAT recommends excluding the Metadefender Kiosk installation directory from
any real-time antivirus protection.

Programs not uninstalled during uninstallation process
If you uninstall Metadefender Kiosk the Microsoft Runtimes, .NET, and IIS Express are not
removed.

1.2. Installing Metadefender Kiosk Using the Install Wizard
1. Go to http://portal.opswat.com/en/product-categories/metadefender-kiosk and click

Download .
Note: If you are not already logged in to the portal, you will be prompted to login.

2. Open the downloaded executable and click Run . The Welcome window appears.

4.1.0
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3. Click Start . The Setup Progress window appears, followed by the Setup Wizard

Welcome window.

4. Click Next . The End User License Agreement window appears.

4.1.0
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4.

5. Read the EULA, select the I accept the terms in the License Agreement checkbox,

and then click Next . The Custom Setup window appears.

6.
4.1.0
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6. Change the default location of the Metadefender Kiosk components, if required, using the

Browse button. Click Disk Usage to view a window that displays the disk space
requirements for Metadefender Kiosk, and the amount of available disk space for the
selected location. Click Reset to reset the location to the default.
Note: It is recommend to install Metadefender Kiosk in the default location.
7. Click Next . The Ready to Install window appears.

8. Click Install . A window appears which displays the status of the installation process,

followed by the Completed window.

4.1.0
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9. Click Finish . The Setup Complete window appears.

10. Click Close . Metadefender Kiosk is now installed.

4.1.0
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1.3. Installing Metadefender Kiosk from the Command Line
Verifying windows installer
To install Metadefender Kiosk from the command line, you must have Windows Installer 3.0 or
higher. To verify what version you have:
1. Open Windows Explorer and go to C:\Windows\System32.
2. Right-click MSI.DLL and select the Properties menu.
3. Click the Details tab to check the version.

If 3.0 or higher is not installed, you can download it at Microsoft.com.

Command line options
The following command line options are available with Metadefender Kiosk. All arguments are
case sensitive.
Command Line Option

Description

Example

/install

Install Metadefender
Kiosk

c:\Metadefender Kiosk.exe /install

/uninstall

Uninstall
Metadefender Kiosk

c:\Metadefender Kiosk.exe /uninstall

/log <log-file-name>

Create installation
log file

c:\Metadefender Kiosk.exe /log c:
\omsinst.log

/quiet

Run Metadefender
Kiosk installation
silently

c:\Metadefender Kiosk.exe /log
c:\omsinst.log

INSTALLLOCATION=<install- Sets the installation
path>
location for
Metadefender Kiosk

4.1.0

c:\Metadefender Kiosk.exe /i
INSTALLLOCATION="c:
\Metadefender"
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1.4. Managing License Information
Metadefender Kiosk requires a valid license to be applied before you can use it. You can apply
your Metadefender Kiosk activation key on the License page in the Metadefender Kiosk
Management Console.

If Metadefender Kiosk is not connected to the Internet, you can use the offline activation
functionality of Metadefender Kiosk. Follow the instructions on the License page to activate
Metadefender Kiosk.

4.1.0
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If your Metadefender Kiosk license has expired or is invalid, the Metadefender Kiosk user
interface displays an error and does not allow you to proceed.

1.5. Upgrading Metadefender Kiosk
You can upgrade Metadefender Kiosk to a newer version. Before upgrading, be sure to back up
your configuration profiles as indicated below.
1. If Metadefender Kiosk is running, close it.
2. Backup your configuration settings and save your data log as instructed in 1.5.1 Backing

Up and Restoring the Configuration.
3. Uninstall Kiosk from control panel add / remove program.
4. Install the new version of Kiosk using one of the following methods:

1.2. Installing Metadefender Kiosk Using the Install Wizard
1.3. Installing Metadefender Kiosk from the Command Line
5. Restore your configuration settings as instructed in 1.5.1 Backing Up and Restoring the

Configuration.

4.1.0
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The Metadefender Kiosk configuration changed with Metadefender Kiosk 4.0.0.
Importing a configuration from versions prior to Metadefender Kiosk 4.0.0 is not
supported.

1.5.1 Backing Up and Restoring the Configuration
To backup or restore the Metadefender Kiosk configuration, click Back Up / Restore in the topright corner of the Configuration page.

Downloading a configuration backup
Click Download Backup to download a file with all of the Metadefender Kiosk configuration
settings saved.

Restoring configuration settings
To restore settings on this or a different Metadefender Kiosk system, upload the configuration
settings file using the Browse button in the Restore From Backup section.

Optional Steps to Preserve Data
If you are installing Metadefender Kiosk on a system where there was a previous version
installed, the following folders should be copied to a safe location prior to upgrading:
Metadefender Kiosk Log Directory
Default Location: C:\Program Files (x86)\OPSWAT\Metadefender Kiosk\Client\Log

1.5.2 Upgrading from Metadefender Kiosk 3.X
4.1.0
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1.5.2 Upgrading from Metadefender Kiosk 3.X
Migrating a deployment from Metadefender Kiosk 3.X to Metadefender Kiosk 4.0.0 or later
requires additional steps because of the differences in Kiosk 3.X and 4.X. In addition to the
standard upgrade procedure, be aware of the following when upgrading from Metadefender
Kiosk 3.X to Metadefender Kiosk 4.0.0 or later.

New Features in Metadefender Kiosk 4.X
1. Completely revamped Kiosk user interface
2. Addition of an optional 'Disclaimer' page in the Metadefender Kiosk workflow
3. Support for multiple end user selected languages in Kiosk UI

Additional Upgrade Considerations
1. Metadefender Kiosk 4.X uses a different licensing mechanism than Metadefender Kiosk

3.X. Please contact OPSWAT to obtain your replacement license for Metadefender Kiosk
4.X.
2. Metadefender Kiosk backup configurations from 3.X can not be imported to 4.X
3. Metadefender Kiosk 4.X requires Metadefender Core 4.7.2 or later
4. Metadefender Kiosk 4.X only supports installation on 64-bit operating systems

4.1.0

32

2. Kiosk Hardening

OPSWAT recommends that the following additional setup is performed if
Metadefender Kiosk is deployed on a dedicated system.
Auto login
If Metadefender Kiosk is being used on a dedicated system we recommend that the Windows
system on the kiosk is configured to auto-login into the account with Administrator privileges
that Metadefender will run with. If the Metadefender Kiosk system is part of a domain additional
steps may be required to allow this.

User Access Control (UAC)
OPSWAT recommends that UAC is disabled on systems that are being used as dedicated
Metadefender Kiosks. If UAC is not disabled Metadefender Kiosk's print functionality may not
work correctly. Metadefender Kiosk's watchdog functionality will also not work correctly if UAC
is not disabled.
There are two ways to completely disable UAC in Windows:

By editing the registry
1. Click Start and type "regedit.exe" to open the Registry Editor.
2. Navigate to the registry key at HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft >

Windows > CurrentVersion > Policies > System.
3. Set EnableLUA to 0.
4. Restart Windows.

By adjusting Local Group Policy settings
1. Click Start and type "gpedit.msc" to open the Group Policy Editor.
2. Navigate to Computer Configuration > Windows Settings > Local Policies > Security

Options.
3. After clicking Security Options, the right pane populates with your policies. Locate the

ones for User Access Control.

4.

4.1.0
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4. Set "Run all administrators in Admin Approval Mode" to "Only elevate executables that

are signed and validated."
5. Set "Switch to the secure desktop when prompting for elevation" to "Disabled."
6. Restart Windows.

Windows Update
Install all patches and updates available through Windows Update. Once all updates are
installed, OPSWAT recommends that automatic updates are turned off to prevent system
reboots.
1. Navigate to Start > Control Panel > Windows Update > Change settings.
2. Select Never check for update s from the menu.
3. Click Apply or OK and close the dialog box.

If turning off automatic updates is not desired, you must configure a mechanism or process to
restart Metadefender Kiosk system. We recommend using standard organizational patch
practices and tools.

Setting the screen saver and power saving options
Select the maximum performance power saving option.
1. Navigate to Start > Control Panel > Power Options.
2. Click Change plan settings .
3. Click Change advanced power settings .
4. Select High Performance from the menu.
5. Click OK .

You should turn off the screensaver.
1. Navigate to Start > Control Panel > Personalization > Change screen saver.
2. Select ( None) from the menu.
3. Click Apply or OK and close the dialog box.

4.1.0
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Disabling mouse cursor pointer
Note: This configuration is optional. Once these steps are taken, there will be no visible mouse
pointer.
OPSWAT recommends that mouse cursor points are turned off after Metadefender Kiosk has
been configured.. If the system touchscreen configuration software does not have this feature, it
can be done manually by following the steps below:
1. Navigate to Start > Control Panel > Mouse.
2. Click the Pointers tab.
3. Browse to C:\Program Files (x86)\OPSWAT\Metadefender Kiosk\Client\blank.cur.
4. Customize each pointer type to the provided blank pointer, blank.cur
5. Click Apply and close the dialog box.

Disabling hotkeys
By default, the Kiosk will ignore any command that is a combination of Ctrl and another key.
The Ctrl + Alt + Del combination is disabled once you launch the Kiosk UI first time. When a
user presses these keys, the following screen appears and it is expected.

if you want to disable completely where nothing happens, please follow 2.2. Disabling Windows
Hot Keys.

4.1.0
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Other system hardening configuration
Metadefender Kiosk does the following system hardening when installed:
Disables auto-run on all plug-and-play media and drives
Captures and disables all Hotkey combinations such as Windows Key, Alt+Tab, etc.

CORS Configuration
see Limit Access to the REST Server for more detailed instruction

2.1. Configuring the Web Server
Metadefender Kiosk's Management Console relies on REST interface which runs on HTTP by
default. You can configure the REST server for the following to harden the system.
changing the default port number
setting up an HTTPS server to enforce a secure connection between server and client
limiting the systems that have access to the REST server

Changing the Default Port Number
You can change the default port number of the REST server to any available port if the default
port number is already in use.
To change the default port number, locate the <binding> tag in the applicationhost.config file
located here: C:\Program Files (x86)\OPSWAT\Metadefender
Kiosk\Client\REST\Config\applicationhost.config.

4.1.0
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Limit Access to the REST Server
You can harden Metadefender Kiosk's cross-origin resource sharing (CORS) configuration to
only allow access to the REST server for a restricted list of systems.
To limit access to the REST server, do the following:
1. Open the web.config file in Program Files (x86)\OPSWAT\Metadefender

Kiosk\REST\Web\web.config.
2. Change the following line:

<add name="Access-Control-Allow-Origin" value="*"/>
to

<add name="Access-Control-Allow-Origin" value="http://localhos
t"/>
3. Next, add a new rule to <system.webServer><rewrite><outboundRules>:

<rule name="Allow CORS on specify ip/subnet" >
<match serverVariable="RESPONSE_Access-Control-AllowOrigin" pattern=".+" />
<conditions>
<add input="{REMOTE_ADDR}" pattern="^(192.168.200.
*|192.168.201.102)$" />
</conditions>
<action type="Rewrite" value="*" />
....
</rule>

Run REST on HTTPS
By default, communication with the REST web server is not encrypted. If you set up an HTTPS
server, the server can enforce secure connections between client and server on an SSL
channel. This section describes how to configure IIS Express to host an HTTPS server.

Requirements
In order to set up an HTTP server, you must have a trusted certificate issued by a certificate
authority or a self-signed certificate used for development testing.

4.1.0

37

See the Installing a Certificate section below for information on how to install a self-signed
server certificate.
Go here for information on how to install a certificate authority-signed server certificate.

Installing a certificate
To install a certificate, do the following:
1. Click on the Start menu, type “MMC.exe” in the search box and press Enter.

The MMC window appears.
2. Select File > Add/Remove Snap-In .
3. In the Available snap-ins drop-down menu, select Certificates and click Add .
4. Select Computer account , click Next , and then click Finish .

Tip: This process creates a certificate for all user accounts. The certmgr.msc command
only creates a certificate for the current user account.

5. Click OK to load the certificates snap-in.
6. Expand the Certificates menu and browse to your certificate location.

Note: The image below uses the metascan_rest certificate as an example. Your
certificate can have any name.
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7. Double-click the certificate name you want to use for the Metadefender REST Server and

go to the Details tab.
8. Select Thumbprint in the list and copy the value to a text editor for later use.

9. Click on the Start menu and open a command prompt.

10.
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10. Execute the following command:

netsh http add sslcert ipport=0.0.0.0:443 appid={214124cd-d05b-4309-9af99caa44b2b74a} certhash=<certificate thumbprint retrieved on step 8>
Note: Be sure to remove any spaces in the thumbprint so the command can execute
properly.
11. The following message appears indicating that the SSL Certificate was successfully

added.

Enabling HTTPS on IIS Express
To enable HTTPS on IIS Express, do the following:
1. Open the REST Config folder (e.g., C:\Program Files (x86)\OPSWAT\Metadefender

Kiosk\Client\REST\Config).
2. Open the applicationhost.config file in a text editor.
3. Go to the <sites> tag and add the HTTPS binding to the ‘metadefender_rest’ website.

Note: See the image below for details.

4. Save and close the applicationhost.config file.
5. Open a command prompt.
6. Stop the Metadefender REST server by executing the following command: net stop

omdREST
7. Restart the Metadefender REST server by executing the following command: net start

omdREST
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8. Test that the site works by visiting https://localhost. The following message should

appear:

9. For additional information see 5.1. Trusting an HTTPS Metadefender Core Server

2.2. Disabling Windows Hot Keys
You can completely disable Windows hot keys Ctrl+Alt+Delete and Windows+L. After disabling
the hot keys, nothing happens when the hot keys are pressed.

Disabling Ctrl+Alt+Delete
1. You must first disable "Windows secure logon", so that you do not need to press

Ctrl+Alt+Delete from the windows login screen. Use one of the following procedures.
Windows 7 - http://pcsupport.about.com/od/windows7/ht/auto-logon-windows-7.htm
Windows 8 - http://www.eightforums.com/tutorials/5761-secure-sign-ctrl-alt-deleteenable-disable-windows-8-a.html
Windows 10 - https://www.tekrevue.com/tip/skip-windows-10-login-screen/
Windows 2008 - http://www.expta.com/2008/04/how-to-enable-autologon-for-windows.
html
2. While signed in as an Administrator, open the command line and run the following

command:

reg add "HKLM\SYSTEM\CurrentControlSet\Control\Keyboard
Layout" /v "Scancode Map" /t REG_BINARY /d
0000000000000000030000004de01de04be01d0000000000 /f

3.
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3. Log out of the system and log in again. To re-enable Ctrl+Alt+Delete, run the following

command line.

reg delete "HKLM\SYSTEM\CurrentControlSet\Control\Keyboard
Layout" /v "Scancode Map" /f

Disabling Windows+L
Run the following command line.

reg add "HKCU\Software\Microsoft\Windows\CurrentVersion\Policies\S
ystem" /v "DisableLockWorkstation" /t REG_DWORD /d 1 /f
To re-enable Windows+L, run the following command line.

reg add "HKCU\Software\Microsoft\Windows\CurrentVersion\Policies\S
ystem" /v "DisableLockWorkstation" /t REG_DWORD /d 0 /f
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3. Management Console for Administration
The Metadefender Kiosk Management Console allows you to manage the Metadefender Kiosk
system through a web browser.
The Metadefender Kiosk Management Console can be accessed through any browser at
http://<Metadefender Kiosk System>:8009/management.
After initial installation, the default password to access the Management Console is set to
"admin".
When you open the Metadefender Kiosk Management Console, the Dashboard appears.
This page displays a summary of all of the files that Metadefender Kiosk has processed.
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4. Kiosk Authentication / User Workflow
Metadefender Kiosk Workflow is based on list of users from the authenticated system. If you
disable user authentication, only one workflow can be applied. Metadefender Kiosk lets you
assign different Kiosk options to different groups of users, called workflows. For example, you
can assign users to an 'Only Docs' workflow if they are only allowed to scan office documents,
and you can assign users to a 'No EXE/Archives' workflow if you want to block all executable
files and archives for these users. You can create new workflows and edit any default ones.
The Workflow Profiles page contains all workflows in Metadefender Kiosk.
For each workflow, you can do the following:
Edit the name and assign users to the workflow
Create and edit user questions
Select the allowed media types
Select a Metadefender Core Server
Select how to handle processed files
Use variables in post-processing scripts
Manage printing options
Manage email options for session scan logs

4.1. Workflow Profiles Page
You can edit or create new workflow profiles on the Workflow Profiles page of the
Metadefender Kiosk Management Console. You can also enable user authentication.
Note: Any users (Windows or Guest) that are not included in one of the defined profiles will be
assigned the Default profile.
Note: Workflow profiles labeled with an "!" do not match with any existing Core profile names
(V3) or security rules (V4). You must select a corresponding Metadefender Core in the
Selecting A Metadefender Core Workflow section.
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The followings are the default workflows:
Name

Description

Default

Users that are not covered by other profiles.

Guest

Account used when Guest Login is selected.

Enabling user authentication
To enable user authentication, select the Require user authentication checkbox on the
Workflows page.
If you enable user authentication, you can choose between using the default Metadefender
Kiosk authentication or using a custom authentication module that has been installed on that
Metadefender Kiosk. For more information, see Managing Custom Authentication. If you are
using the default Metadefender Kiosk authentication you can choose between authenticating
against the local Active Directory (Windows user login), a remote Active Directory server, or not
enabling authenticated login.
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Windows user login
If Windows user login is enabled, you can choose whether to restrict the users by domain. If
selected, only users on the same domain as the Metadefender system are allowed to use
Metadefender through the Kiosk interface. If this is not selected, users will be able to enter
authentication information for users on any domain as well as local system users.

Remote Active Directory
If Remote Active Directory authentication is enabled, the URL of the remote Active Directory
server, as well as user credentials to authenticate against the server are required. These
credentials will be used to retrieve the list of users from the remote Active Directory server for
the purposes of assigning users to specific workflows.
Note: when using the Remote Active Directory authentication the Kiosk end user credentials
are not used for copying files as part of the Metadefender Kiosk workflows.
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A message under the "Password" field will show in real time whether Kiosk is able to connect to
the AD server.

Creating a new workflow profile
To create a new workflow profile, click Create New Profile . You will be guided through the
process of creating a new Metadefender Kiosk Workflow profile. After the profile has been
created, each step in the workflow can be edited independently.

4.2. Properties & Membership
The Properties & Membership page lets you specify the name and description for a
Metadefender Kiosk workflow profile. It also lets you manage the users assigned to that profile.
You can add both domain users (the domain of the Metadefender Kiosk system) as well as
local system users. To be able to configure profiles with domain users, the Metadefender Kiosk
system must be part of the domain or be able to authenticate with a remote Active Directory.
To add users to the profile:
1. Select the user(s) from the Available To Add section.
2. Click Add . The user(s) appear in the Members section.

To remove users from the profile:
1. Select the user(s) from the Members section.
2. Click Remove . The user(s) appear in the Available To Add section.
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if you assign a user who is already on another workflow to new workflow, the user will
be removed from the previous workflow and assigned to the new workflow.

4.3. Managing User Questions
The User Questions Policy page lets you create questions for users to answer before
processing files. You can require that these questions be answered before the user is allowed
to continue. Any required responses are stored in the User Question section of the session log.
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4.4. Allowed Media Types
The Allowed Media Types page lets you select which media types (CDs/DVDs and/or floppy
disks) Metadefender Kiosk can process for the selected workflow profile.
The USB Whitelisting functionality allows you to define a whitelist of USB devices that will be
allowed by Metadefender Kiosk. When this is enabled, only USBs that match to the whitelist will
be allowed.

The USB whitelist can include as many items as the administrator would like to define. Any
USB that has a device ID that either equals or contains any of the items in the whitelist will be
allowed. For instance, if one of the items in the whitelist is
"USBSTOR\DISK&VEN_GENERAL&PROD_UDISK&REV_5.00", both
"USBSTOR\DISK&VEN_GENERAL&PROD_UDISK&REV_5.00\208&0" and
"USBSTOR\DISK&VEN_GENERAL&PROD_UDISK&REV_5.00\336&0" would be allowed, but
"USBSTOR\DISK&VEN_GENERAL&PROD_UDISK&REV_5.01\404&0" would not.
Device IDs of USBs from previous scan sessions can be found in the Session History page.

4.5. Selecting A Metadefender Core Workflow
In order to use the multi-scanning functionality of Metadefender Core, Metadefender Kiosk
requires a Metadefender Core Server. The Metadefender Core Server can be installed either
locally on the same system as Metadefender Kiosk or remotely on another machine. The
Metadefender Core Workflow page lets you select if you want to use a Metadefender Core
Server to process files. By default, Metadefender Kiosk uses a locally installed Metadefender
Core Server if one is available. To specify a remote Metadefender Core Server, use the
Remote Metadefender Core Server URL option in the Advanced Configuration settings of the
Configuration page.
4.1.0

49

The Security Rule drop-down menu determines which Metadefender Core security rule is used
to process files from Metadefender Kiosk.
When used with Metadefender Core version 4.8.0+, a media manifest can be added to media
scanned by Metadefender Kiosk. This settings enables the creation of a signed Media Manifest
that contains the scan results for all files that were scanned as part of the session. This
manifest can be validated by other Metadefender products.
A max file size can be specified for files to be scanned by Metadefender Core, all files larger
than this will still be processed by Kiosk without being processed by Core. The files that are
larger are treated as allowed and are marked as skipped.

4.6. Selecting How to Handle Processed Files
The File Handling page is divided into two sections: actions to take on blocked files, and
actions to be taken on allowed files. You can set different file handling options for each,
including copying to either new media or a network path.
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Stop processing if a blocked file is found
Selecting this option will cause a Kiosk session to stop processing immediately after the first
blocked file is found. Kiosk will alert the user that a blocked file was found and go directly to the
session summary after the user has acknowledged the message.

Deleting, removing or taking no action on files
You can choose for this workflow to automatically delete blocked or allowed files that have
been sanitized by Metadefender Core, take no action on blocked or allowed files, or remove
non-sanitized blocked files.
To delete blocked or allowed files that have been sanitized by Metadefender Core, select the If
a file has been sanitized by the Metadefender Core workflow, delete the original file
checkbox.
To take no action on blocked or allowed files, select the No Action radio button.
To remove any non-sanitized blocked files, select the Remove file radio button, then select
Quarantine or Deleted from the drop-down menu.

Copying files to a designated location
You can configure files to be automatically copied to a designated location as part of the postprocessing step in the Copy to section. Metadefender Kiosk will copy files to the directory
specified by one of the three naming conventions below, depending on which option you select.
Note: If a file has been sanitized by Metadefender Core's Data Sanitization and Copy to is
selected here, the sanitized file will be copied to the desired location, not the original file.
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Directory
The Directory field allows you to specify a specific location for blocked or allowed files.
The pre-defined ‘%%%username%%%’ variable can be used within the designated location in
the Directory field to allow Metadefender Kiosk to copy files to a folder (e.g. ‘username’). This is
for the user logged into the session. When Windows authentication is not enabled, or guest
login is used, the %%%username%%% variable is replaced by the session ID.
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Responses to user questions can also be utilized in the Directory field via the pre-defined '%%%
userresponse#%%%' variable, where '#' is the number of the response to the corresponding
user question.
For example, to utilize the answer to the question 2, the variable to use would be '%%%
userresponse2%%%'.
If no response to the question was given or no such question exists for the user response to
exist (e.g. %%%userresponse999%%%), then the variable will exist in the path created.
You can copy files to a remote server(network share) by providing a UNC path. To allow for
more restrictive permissions on a network share, a Metadefender Kiosk profile will need to be
created containing users that have, at minimum, write permission to the network share. When a
user logs into a session, Metadefender Kiosk will attempt to use the permissions of the user to
copy files to the network share.
This section contains three directory name options:
Copy to directory named with the unique session ID: Copies files to a directory
identified by the session ID.
Copy to directory named with the session start time (GMT): Copies files to a
directory identified by the session start time.
Keep the same folder structure as on original media (no subfolders): Copies files to
the same directory as in the original media.

User media
You can also enable files to be copied to media that the Kiosk user provides. If you select the
User media checkbox, the user will be prompted to insert media that the files are to be copied
to. You can also select the Allow Copying to Floppy Drives option, if desired.

Metadefender Secure File Transfer Server
See 6. Configuring with SFT for instructions and more details.

Only Copy Sanitized Files
This option only exists for blocked files.
If enabled, only sanitized versions of blocked files will be copied to the destination.
Any blocked file that was not sanitized will not be copied.
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SHA-256 Verification
If enabled, Metadefender Kiosk compares the hash value of files on the target directory with the
ones from the original directory.
Any mismatches are displayed and logged.
No retry of the copy is performed in the case of a hash value mismatch.

Delete after copy
Select this checkbox if you want Metadefender Kiosk to delete the blocked or allowed file after
copying it to the specified location.

4.7. Custom Command Line Script
How To Configure
The File Handling page also allows you to run post-processing scripts via the Run custom
command line script option. You can use variables from the table below in post-processing
scripts. After entering your scripts, click Apply .
For example, the following command line will copy the file that was analyzed by Kiosk to "E:
\MD_POST_ACTION_BY_PAC" folder and delete after the copy.

copy /y %%%file_path%%% E:\MD_POST_ACTION_BY_PAC
del /q %%%file_path%%%

Be sure to test the script before configuring with Kiosk as the script is not validated.

Using Pre-defined Variables in Your Command Line Scripts
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Using Pre-defined Variables in Your Command Line Scripts
Variable

Description

Notes

%%%file_path%%%

The absolute path of the file scanned

%%%
threat_name%%%

The name of the threat found by the engines

This variable only
applies to infected
scan results (“1”)

%%%
scan_finished%%%

The time when the scan was finished

Local time of the
kiosk system

%%%ticket_id%%%

A random number assigned to each Kiosk
session

%%%
scan_results%%%

The scan outcome return type. The scan
outcome return types are listed below:
0 - No threat found: No threat detection
or the file is empty
1 - Infected/Known: Threat is found
2 - Suspicious: Classified as possible
threat but not identified as specific threat
3 - Failed To Scan: Scanning is not fully
performed (for example, invalid file or no
read permission)
4 - Cleaned: Threat is found and file is
cleaned (repaired or deleted)
5 - Unknown: Unknown scan result
6 - Quarantined: File is quarantined
7 - Skipped Clean: Scan is skipped
because this file type is in whitelist
8 - Skipped Dirty: Scan is skipped
because this file type in in blacklist
9 - Exceeded Archive Depth: Threat is
not found but there are more archive
levels which were not extracted
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Variable

Description

Notes

10 - Not Scanned: Scan is skipped due
to an engine update or other engine
specific reason or the file was not sent to
Core
11 - Aborted: All ongoing scans are
purged by StopScan API call
12 - Encrypted Archive: Archive is not
scanned because it is detected as
encrypted
13 - Exceeded Archive Size: The
extracted archive is larger than set in the
maximum file size for archive
14 - Exceeded Archive File Number:
There are more files in the archive than
set in the maximum number of files
extracted
15 - Password Protected Document:
File is not scanned because it is detected
as password protected
16 - Exceeded Archive Timeout: The
time to scan the archive took longer than
the time set for scanning an archive
17 - Filetype Mismatch: The detected
filetype does not match filetype attached
to the file
18 - Potentially Vulnerable File: The file
is known to have some potential
vulnerabilities
%%%
The process outcome
process_result%%%
Allowed
Blocked
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4.8. Managing Printing Options
The Printing Policy page lets you determine whether users have the option to print a receipt of
their session and if so, what information will be included on the receipt. You can also choose to
have the receipts print automatically at the end of each session.
Note: Metadefender Kiosk will use the printer which is set to default to the system.

4.9. Email Session Report
The Email Session Report page lets you set up automatic emails that are sent to a designated
recipient after each session is completed. The email includes the session log as an attachment.
To enable this feature, move the slider on the right hand side of the page to On .
SMTP settings are configured in the Advanced Configuration section of the Configuration page.
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5. Configuring a Metadefender Core Server
Metadefender Kiosk requires a Metadefender Core Servere for multi-scanning functionality.
Metadefender Kiosk automatically connects with a Metadefender Core Server that is installed
locally on the same system as Metadefender Kiosk. However, if you are using a remote
Metadefender Core Server with your installation of Metadefender Kiosk, configure your
Metadefender Core Server as detailed below.
Setting up your Metadefender Core Server with Metadefender Kiosk consists of the following
steps.
Detecting the Metadefender Core server URL
Authenticating your configuration
Associating workflows in Metadefender Kiosk to workflows in Metadefender Core

Detecting the Metadefender Core server URL
If Metadefender Core is installed on a remote machine from Kiosk, the server URL must be
specified.
1. Access your Metadefender Kiosk Management Console at http://<Metadefender Kiosk

System>:8009/management. You can also access the Kiosk Management Console using
Windows Start > OPSWAT > Metadefender Kiosk Management Console.
2. Click Configuration and enter your Metadefender Core Server's URL.

3. You can enter a backup server if you have one, in case the primary server become

inaccessible, its license expires, or other issues the primary server might encounter.
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Authenticating your configuration
You must authenticate your configuration by obtaining the API key from the Metadefender Core
Management Console and entering that information on the Kiosk Management Console's
Configuration page.
1. To obtain your Metadefender Core API key, access your Metadefender Core

Management Console.
2. Click Settings and then click User Management .

3. Click any user name and c opy the contents of the APIKEY field. If an API key has not

been previously generated click the 'Generate' link to generate a unique API key for that
Metadefender Core user.

4. Click OK to save and close the window.
5. Return to the Metadefender Kiosk Management Console and click the Configuration

tab.
6. Paste your Core API Key value in the API Key field.
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Associating workflows in Metadefender Kiosk to workflows in
Metadefender Core
Refer to 4.5. Selecting A Metadefender Core Workflow.

5.1. Trusting an HTTPS Metadefender Core Server
In order to allow a Metadefender Kiosk to work properly with a Metadefender Core server,
configured to use HTTPS, the certificate must be trusted on the system the Metadefender Kiosk
resides on.

Trusting local or remote self signed security certificate
If you are using this guide on the local computer you should access and install the certificate
from the DNS address (e.g. https://frosty7c/)
1. Open Internet Explorer and access the Metadefender Core dashboard (e.g.

https://frosty7c/)
2. Click Continue to this website

3. Click Certificate error

4. Click View certificates

4.1.0

61

4.

5. Click Install Certificate...

6. Select either Current User or Local Machine and click next

7.
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7. Select Place all certificates in the following store and click browse

8. Select Trusted Root Certification Authorities and click OK

9. Select Next, then select Finish
10. Restart your Internet Explorer and navigate to the same page again
11. You should now see a locked padlock instead of a certificate error

12. Run certmgr.msc
13. Select Trusted Root Certification Authority → Certificates
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13.

14. Right click the DNS name → All Tasks → Export

15. Click Next → Next → Browse
16. Choose anywhere to save the certificate and hit save
17. Click Next → Finish
18. Run mmc
19. File → Add or Remove Snap-in
20. Select Certificates and click Add
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21. Select Computer account and hit next

22. Click finish then click ok
23. Select Trusted Root Certification Authority → Certificates
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24. Right click Certificates → All Tasks → Import

25. Click next
26. Select the file you created previously
27. Click Next → Next → Finish
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6. Configuring with SFT
Change on management console

If you select the Metadefender Secure File Transfer Server checkbox, you must also enter the
following information:
Server URL: Enter SFT REST server's URL in this field.
Add Token: Enter token information in this field. You can obtain token information from
the Metadefender Secure File Transfer management interface.
Select an SFT account option for file uploads: Choose an SFT account option in this
section.
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Maximum File Upload Size: Choose a size limit for uploaded files.

SFT account options for file uploads
If you select the Always upload to an SFT guest account radio button, Metadefender
Kiosk creates and provides a temporary guest login ID to the Kiosk user both on the
scan results screen as well as in the digital and printed logs.
If you select the Attempt to use user credentials if they are available radio button,
Metadefender Kiosk uploads files to the user account that matches the one used during
authentication.
If authentication fails, files will be uploaded to the SFT guest account.

6.1. Arbit Data Diode configuration
This guide describes how to deploy Metadefender Kiosk, an Arbit data diode, and a
Metadefender SFT server for the following use case.
1. Portable media is scanned by Metadefender Kiosk.
2. Clean files are passed through an Arbit data diode to an SFT Server.
3. User downloads files from the SFT server.

System Deployment
The following should be done before configuring the individual systems.
1. Install Metadefender Kiosk with Metadefender Core on the low-side network
2. Install the Arbit data diode with the receiving side in the low-side network and the

transmitting side on the high side network
a. Assign a static IP address to the low side
b. Assign a static IP address to the high side
3. Install the SFT server on the high side network
a. Assign a static IP address

SFT Server Configuration
1. Create the known user accounts on the SFT server
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1.

a. Note the account that should be used as the 'from' account for files coming from

Metadefender Kiosk
2. Generate the Authorization token

Arbit Data Diode Configuration
1. Define the URL list on the high side of the data diode to include the SFT server
a. URL List includes http://<SFT IP Address>:8000/sft_rest/file

Metadefender Kiosk Configuration
1. Configure the appropriate Metadefender Kiosk workflow profile to enable Copy To SFT in

the post-action
2. Put in the URL of the data diode low-side receiver
a. http://<diode low-side IP address>:8080/pitcherrestapi/transfer/<URL List>
3. Enter the Authorization token generated by the SFT Server
4. Enter the Sender SFT account that was created on the SFT server
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7. Additional Kiosk Configuration
The Metadefender Management Console allows you to manage the Metadefender Kiosk
system through a web browser. The Metadefender Management Console can be accessed
through any browser at http://<Metadefender Kiosk System>:8009/management
Note: If a license has not been previously applied to a Metadefender Kiosk installation, opening
the Metadefender Management Console will direct the user to the ‘License’ page so that a
Metadefender license can be applied.

Dashboard
The Dashboard will be the first page that is seen when opening the Metadefender Management
Console. This page provides a summary of all of the files that have been processed by
Metadefender Kiosk.

4.1.0

70

Configuration
The Configuration page allows you to configure all Metadefender Kiosk settings that apply to all
users of Metadefender Kiosk . Metadefender Kiosk configuration settings can also be saved
from this page to be restored at a later date or on another Metadefender Kiosk system.

Advanced configuration options can be set by expanding the ‘Advanced Configuration’ section
of the Configuration page. To display advanced options, click on the arrow to expand the
settings
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7.1. UI Localization / Customization
You can change the language displayed in Metadefender Kiosk from the ‘Choose Language’
drop-down menu. The default languages included in the installation are English, Arabic,
Hebrew, Korean, Vietnamese, German, and Japanese. Furthermore, if you wish to add a
language to the Metadefender Kiosk UI or edit the translations of any of the existing languages,
you can do so by clicking on ‘View and edit languages’.
After clicking 'View and edit languages' you can edit the translations for any of the strings which
appear in Metadefender Kiosk. You can choose which language to edit from the drop-down
menu next to ‘Choose language to update’. Once finished, click on ‘Apply’ at the bottom of the
page.
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If you wish to add a new language, click ‘Add Language’ and type in the desired language. On
the following page you can create translations for each of the strings to be displayed in
Metadefender Kiosk.

If the language you are adding reads right to left, make sure to check that box when
editing your added language.
Languages can be either disabled or enabled through the Management Console.
Disabled languages will not be available to Kiosk users as options.
The Language Order value will determine the order in which languages are displayed to
Kiosk users when they are selecting a language in the Kiosk user interface. Lower
numbers will be displayed first.
Once finished, click ‘Save’ at the bottom of the page and your language will now appear in the
Advanced Configuration section where it can be selected.
Additionally, in the Advanced Configuration section, "Allow user to select languages" controls
whether users can select which language to use from the UI.
If the option is deselected, the current active language will be locked in and users will not be
able to modify which language to display.
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7.2. Watchdog Behavior
The watchdog is an additional process that monitors the running processes of the
Metadefender Kiosk.
In the case where the Kiosk exits unexpectedly, the watchdog will run a specified action to take.

Configure watchdog behavior

Action

Description

Do nothing

No action will be performed, the system will remain on the secure desktop

Restart
Metadefender
Kiosk

Metadefender Kiosk will be restarted while the system remains on the
secure desktop
For a brief moment, a blank secure desktop will be displayed before the
Metadefender Kiosk starts up again

Log out of
Windows

The user currently logged into Windows will have their session terminated
and be logged out
The system will exit out to the Windows OS login

Lock
Windows

The user currently logged into Windows will be locked out
The system will exit out to the Windows OS login where the admin must log
back into Windows

Restart
Windows

The Windows system will be rebooted
The system will either return back to the Windows OS login or be logged in
to the default Windows user (this is dependent on the system's automatic
login settings)
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7.3. Configuring User Settings
The Configuration page lets you configure user settings for Metadefender Kiosk. You can also
save configuration settings to be restored at a later date or on another Metadefender Kiosk
system.

Setting an exit password
Select the Exit Password checkbox to require users to enter a password when exiting
Metadefender Kiosk. After selecting this checkbox, two fields appear: New password and
Confirm password .

Entering API Key information for Metadefender Core
If you have configured Metadefender Core server to use an application programming interface
(API) key, you can enter that key in the API Key field.
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Configuring session log files
You can save session log files as a text or PDF file, and choose to save log files to a specific
location on the system or to the processed media. By default, Metadefender Kiosk saves
session log files to the Log folder in the Metadefender Kiosk installation directory.

To save session log files:
1. To save session log files to the local system, select the Save session log file to local

system checkbox. Note: This checkbox is selected by default. To disable this feature,
deselect this checkbox.
a. To have the session log files save to the Log folder in the in the Metadefender

Kiosk installation directory, do nothing.
b. To enter a specific location other than the Log folder, enter the path of the folder in

the text box provided.
2. To save session log files to the media being processed, select the Save session log file

to processed media checkbox. This setting will not apply to read-only media, such as
CDs or DVDs.
3. Select the Save as Text File or Save as PDF radio button, depending on the output type

of the session log files you prefer.
4. Display the Metadefender Core Server URL used in the session log allows for the

Core URL, that was used for the session, to be displayed in the log file. This is useful
when configuring a backup Core server and determining which server was used for a
particular session.
Note: The save options are independent from each other. You can save session logs locally
and/or save it to the processed media or disable session log files altogether.

Setting advanced configuration options
You can set advanced configuration options by expanding the Advanced Configuration section
of the Configuration page. To display advanced options, click the arrow.

4.1.0

76

Max number of parallel scan
The recommended value of parallel scans is 3x the number of physical processing cores
available or 20, whichever is greater.

Multiple Partitions
Multiple Partitions

Option

Only 1
Windows
Partition

Only
Windows
Partitions

Mixed Windows
and Non
Windows
Partitions

Only Mac /
Linux
Partitions

Block all media with
multiple partitions

SCAN ONE

BLOCKED

BLOCKED

BLOCKED

Process files on all
accessible partitions

SCAN ALL

SCAN ALL

SCAN ALL

BLOCKED
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The

SCAN ALL

action will mount every partition it can successfully mount. All partitions will

be scanned by "Process All." The file browser will have the ability to select files on any partition.

Managing the display language
You can also change the default language displayed in Metadefender Kiosk from the Choose
Language drop-down menu. Options include English, Arabic, Hebrew , Korean, Vietnamese,
German or Japanese. If you wish to add a language to the Metadefender Kiosk UI or edit the
translations of any of the existing languages, click View and edit languages .

Session Report Email configuration
The last group of configuration options in the Advanced section are the SMTP settings for
emailing session logs at the end of a session. Here you can enter the host, port, username and
password, and whether or not to enable SSL. The sender, recipient, and the message of the
email is configured per Metadefender Kiosk Workflow.

Configuration Field Descriptions and Default Settings
The following table provides a brief description and default values for the Kiosk Configuration
screen.

Basic Configuration
Configuration
Setting

Description

Default Value

Remote
Metadefender
Core Server URL

URL of primary remote Core server

(Blank)

API Key

4.1.0
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(Blank)
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Configuration
Setting

Description

Default Value

Range

The API Key of the primary remote
Core server, if one is set

Backup Core
Server

URL & API key input for an additional
Core server for the Kiosk to use if the
primary is inaccessible

(Blank)

Printer Setup

Select the color of the printing output:
Black & White or Color

Black & White

Side margins

Left and right margin length

3

Recommended settings:
3 for zebra printer
200 for laser jet
Display the Core
URL in the
session printout

The URL of the Core used for a
session will be displayed on the
printout

Disabled

Save session
log file to local
system

Enables a session text/PDF log to be
created at the end of a session in a
location on the system

Enabled

Save session
log file to
processed
media

Enables a session text/PDF log to be
created at the end of a session on the
media processed

Disabled

4.1.0

0 or
greater

Logging directory:
<kiosk install
dir>\Client\Log

If enabled, the log will
be saved to the root
of the media
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Configuration
Setting

Description

Default Value

Save as Text
File / Save as
PDF

Specifies whether the session log file
will be a text or PDF file

Text file

Display the Core
URL in the
session log

The URL of the Core used for a
session will be displayed on the log file

Disabled

Wipe Method

Specifies which wipe options to display
to the user

All wipe methods
shown

Format
1 pass wipe
3 pass wipe
7 pass wipe

Exit Password

Require password when terminating
the Kiosk UI (ALT + F4)

Disabled

Watchdog

Custom action watchdog that will run
when the Kiosk UI is unexpectedly
terminated

Restart Windows

Range

0,1,3,7
pass
wipe

Do nothing
Restart Metadefender Kiosk
Log out of Windows
Lock Windows
Restart Windows
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Advanced Configuration
Configuration
Setting

Description

Default Value

Range

Max number of
parallel scans

Maximum amount of concurrent process
requests Kiosk will make to the Core
server

20

0 or
greater

Max number of
retries when
Metadefender Core
is too busy

Maximum amount of retries that Kiosk will
attempt on a file when the Core server
notifies that it is too busy to handle new
requests
Once the maximum amount of retries is
reached for a file, the session will be
canceled

0

0 for
infinite

Allow decryption
of encrypted
archives

Allows you to input passwords when
encrypted archives are detected

Enabled

Skip processing
BitLocker system
files

Enables skipping of system files on media
encrypted by BitLocker that Core cannot
access and will typically result in a failed
scan

Disabled

User Interface
Timeout

The time the Kiosk UI will wait for a
session to begin before automatically
switching back to the idle screen

5 minutes

Display disclaimer
screen

Display the disclaimer screen to a user
when a new session is started

Enabled

Allow user to
browse for files

Allow user to select files before
processing media

Enabled

4.1.0

100 or
greater

60
seconds
or
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Configuration
Setting

Description

Default Value

Allow user to
process all files

Allow user to select to process the entire
media

Enabled

Alert user if
Metadefender Core
license is close to
expiration

Alerts you on the Kiosk idle screen if the
Core license is close to expiration

Disabled

Alert user if
Metadefender
Kiosk license is
close to expiration

Alert you on the Kiosk idle screen if the
Kiosk license is close to expiration

Disabled

Reboot at end of
session

Specifies if the system should reboot after
a session completes

Disabled

Allow user to
select languages

Allow user to select which language the
Kiosk UI's text will be displayed as
If this setting is disabled, the default
language selected will be locked in

Enabled

Available
Keyboards

The keyboards allowed for users to select
within the on-screen Kiosk keyboard

All keyboards
enabled

Choose Language

The default language to be used for the
UI

English

Multiple Partitions

Selects the method for processing files on
partitions

Process files
only on
accessible
primary
partition

4.1.0

Range

82

Configuration
Setting

Description

Default Value

Host

IP or DNS of SMTP server

127.0.0.1

Port

Port of the SMTP server

25

Enable SSL

Enable the use of SSL

Disabled

Username

Username to authenticate to the SMTP
server

(Blank)

Password

Password to authenticate to the SMTP
server

(Blank)

Range

7.4. Session Logs
Metadefender Kiosk displays the most recent scanning sessions on the Logs page. You can
select any of these sessions to view details from that scanning session.
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Searching by file hash or session ID
You can also search Metadefender Kiosk logs by either file hash (SHA256) or by Metadefender
Kiosk session ID on the Session History page.

If you search by session ID, Metadefender Kiosk displays a summary of the results of that
session. Click any of the list items in the summary page to display the individual files that were
included in that Metadefender Kiosk session.
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Searching by specific file name
Click Want to upload a file to search to upload a file to check if it has been processed by
Metadefender Kiosk.
If you search by SHA256 hash code, Metadefender Kiosk displays a summary of all of the
times that file was processed by Metadefender Kiosk.

Viewing session details
Click any of the items in the list to display details from the specific processing sessions.

Similarly, you can click any of the items in the new list to display the details from that specific
session.
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7.5 Alert Sound Customization
To change the alert sound when threats are detected, replace <Kiosk install
directory>\Client\en\resources\sounds\alarm.wav with your own .wav file.
The file name must be maintained or Metadefender Kiosk will not recognize the sound to play.

7.6 Branding and Logo Customization
Some of the images and logos in the Metadefender Kiosk end user interface can be changed
by replacing the images installed with Metadefender Kiosk.

Home Screen
Three images can be modified on the Metadefender Kiosk home screen.

Background Image
Replace the file C:\Program Files (x86)\OPSWAT\Metadefender
Kiosk\Client\en\resources\main-screenshot.png

Top Center Logo
Replace the file C:\Program Files (x86)\OPSWAT\Metadefender Kiosk\Client\en\resources\logo.
png

Footer Logo
Replace the file C:\Program Files (x86)\OPSWAT\Metadefender
Kiosk\Client\en\resources\secondary-logo.png
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8. Launching Metadefender Kiosk
The Metadefender Kiosk application automatically launches upon system startup. If there is a
system malfunction and you restart the system, Metadefender Kiosk re-initializes upon startup
After startup, the Idle Screen displays.

If your Metadefender Kiosk license has expired or is invalid, the Metadefender Kiosk application
displays an error and does not allow you to proceed.
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8.1. Exiting the Kiosk User Interface
To exit the Kiosk UI, press Alt+F4. When exiting the UI, it may take a few minutes if Kiosk is in
the middle of processing media. It is not recommended to exit the UI while Kiosk is processing
media. It is strongly suggested to set the exit password in order to prevent a non-administrator
from accessing the system.

To set exist password on management console:

When exit password is configured:
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9. Using the Metadefender Kiosk End User Interface
The following sections give an overview of the end user experience in using the Metadefender
Kiosk. The exact experience will depend on how each Metadefender Kiosk instance is
configured.

9.1. Logging In on the User Authentication Screen
If user authentication is required, you must login either as a Guest or an Employee user
account. If both of those options are enabled, the following screen is displayed.

If you login with an Employee account (or if only the Windows user authentication is enabled
and the guest login is disabled) the Log In screen displays:
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If you log in as a Guest, or if only the Guest login is enabled (and the Windows login is
disabled), you must answer the user questions defined for the Guest profile (see Answering
User Questions).
After logging in with either your Windows credentials or as a Guest, your workflow is
determined by the workflow profile settings configured in the Metadefender Kiosk Management
Console. For more information on configuring multiple workflow profiles, see 4.1. Workflow
Profiles Page.

Answering User Questions
If your workflow profile (either as a guest or domain user) specifies user questions, the
questions are displayed. Answer the questions, and then click Submit .
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9.2. Inserting Digital Media
After the login process is complete and, if applicable, all user questions have been submitted,
the Insert Media screen displays.

At any point during a session, if a device is inserted that Kiosk cannot process, an alert will pop
up indicating it detected a new device.
For example, in the event a mouse is connected:
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9.3. Unlocking Encrypted Devices
If the device you are trying to scan is encrypted, a prompt to unlock the device is displayed.
See the Overview for a list of encrypted USB drives that are supported.

9.4. Processing Digital Media
1. Insert the media you want to scan. The Scan selection screen appears.
2. Click Browse . (If you want to scan the entire media, click Scan All and skip to step 5.)

All detected drives display. Files and folders are not sorted.
Note: Click Wipe Media to remove all data from the detected media and overwrite the
entire disk with random data, depending on the configuration set in the Metadefender
Kiosk Management Console.
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3. Select the drive, folders, or files (including system files) you want to scan and click

Continue .
Note: Boot Records in the figure below means the Master Boot Record and Volume Boot
Record; they will be processed if selected.

4. The Progress screen displays the following information:
a. Counts of current file results (e.g. allowed files, blocked files, skipped files)
b. The progress percentage on the media icon
c. The number of files of scanned out of the total number files to be scanned
d. The size of files scanned out of the the total size of files to be scanned
e.
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e. If any blocked file is found, the path of the file is temporarily displayed

Note: If the inserted media does not have Windows-readable partitions, or if
multiple partitions have been disabled in the Metadefender Kiosk Management
Console and the drive has multiple partitions, the No volumes mounted for the
selected device error message appears and you will be returned to the Idle
screen. This error message also appears if Metadefender Kiosk is unable to read a
partition because it is a private or encrypted partition.
5. If at least one encrypted archive is found, and encrypted archive decryption is enabled in

the Metadefender Kiosk Management Console, a list of the encrypted files display. See
9.5. Processing Encrypted Archives for additional information.

6.
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6. When scanning is complete, the Sessions Results screen displays. See 9.6. Viewing the

Session Results.
Note: If you click Cancel during the scan, the Session Results screen will be displayed. If
media is removed during scanning, the session will end and return to the idle screen.

Wipe Media
Media can be wiped to delete all of the files on the device and make it harder for data to be
recovered using specialized tools that can read the remnants of files that were previously on
the disk.
There are four options:
Format
1 Pass
3 Pass
7 Pass
Format is the fastest option, but it simply removes the references to the files on the drive
without overwriting those portions of the drive.
The 1, 3, and 7 pass wipe options write over the entire drive with differing algorithms, making it
much more difficult to retrieve the data that was originally stored on the drive.
The United States Department of Defense recommends using a 7 pass wipe to clean media.
OPSWAT does a low-level sector by sector wipe of the media.
Using the wipe feature will completely erase and reformat ALL information on the device. This
includes the partition table and master boot record along with any file system information.

Algorithm Details
Num.
of
Passes
1

Algorithm Steps in
Order

1. Pseudorandom

Security Standard

British HMG Infosec Standard 5, Baseline Standard
Australian Government ICT Security Manual 2014 Controls

3

1. All 1's

U.S. DoD Unclassified Computer Hard Drive
Disposition*

2. All 0's

U.S. Air Force System Security Instruction 5020**
3. Pseudorandom
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Num.
of
Passes

Algorithm Steps in
Order

Security Standard

U.S. Navy Staff Office Publication NAVSO P-523926
British HMG Infosec Standard 5, Enhanced Standard
*We use pseudorandom instead of a fixed pattern as our
final pass
**We select 0xFF and 0x00 (reverse of standard), then
pseudorandom data instead of a fixed character for our
final pass
7

1. All 1's

Bruce Schneier's Algorithm: Applied Cryptography,
ISBN 0-471-12845-7

2. All 0's
3. Pseudorandom
4. Pseudorandom
5. Pseudorandom
6. Pseudorandom
7. Pseudorandom

9.5. Processing Encrypted Archives
If at least one encrypted archive is found during processing (as described in 9.4. Processing
Digital Media), and encrypted archive decryption is enabled in the Metadefender Kiosk
Management Console, a list of the encrypted files displays.
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To process encrypted archives:
1. Select the checkbox next to one or more of the encrypted archives. A password screen

appears.

2. Enter the password for the encrypted archive, and then click Submit .

Note: If you selected multiple encrypted archives, you are prompted to enter different
passwords for each archive or select to apply the same password to all archives.
3. Click Unlock to scan the selected encrypted archives . If the encrypted archives are

successfully unlocked, the Session Results appear.
Note: Click Skip to bypass the encrypted archives and go directly to the Session Results
screen.
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9.6. Viewing the Session Results
After media has been processed, the session results appear. The session results include
whether processing was completed or aborted, the number of files allowed and blocked and the
total number of files processed.

The session result page includes the following buttons:
Allowed: If allowed files are found, then the Allowed count will appear. Click this button
to go to the Allowed file summary screen.
Blocked: If blocked files are found, then the Blocked count will appear. Click this button
to go to the Blocked file summary screen.
Copy & Print: Clicking this button will begin the file transfer process to any destination
configured. If printing is enabled, the session results will be printed to the default printer.

Viewing details about blocked files
The Blocked File Details screen displays the blocked files detected by Metadefender Kiosk
during processing. You can click a blocked file to view more details. Click the Back and Next
buttons to toggle between blocked files.
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Mismatched files have extensions that do not match the expected file type based on the
content of the file. A mismatched file is not always a threat; many custom files or files
generated by custom software have extensions that are different than standard file types. You
should evaluate mismatched files on a case-by-case basis to determine whether the file is a
potential threat.

Data Included in Metadefender Kiosk Log Files
After scanning is complete, you can print the scanning session log file. Click Print from the
Session Results screen or after transferring files.
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See 9.6. Viewing the Session Results for more information.
The following information is included in the printout.
Data Item

Description

User ID

If you are using Windows authentication, this is your Windows user ID. If
you are not using Windows authentication, this is blank.

Profile

The Metadefender Kiosk profile that was used for this session.

Session ID
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Data Item

Description
The unique session ID generated for this Metadefender Kiosk processing
session.

Scan
Completion
Status

PROCESSING FINISHED SUCCESSFULLY or

Start Time

Processing start time.

Finish Time

Processing finished time.

Metadefender
Core Version

The product version of the Metadefender Core server. If the Metadefender
Core server is installed remotely on another system, the IP address and
communication method (e.g., metascan_rest) is listed as well.

Metadefender
Kiosk Version

The product version of the Metadefender Kiosk application.

Device
Information

Section that includes identifying information for the physical media device
that was scanned, if available, from the device.

Manufacturer

Manufacturer of the media that was processed.

Model

The model of the physical media that was processed.

Media Type

The type of physical media that was processed.

PROCESSING ABORTED!

Serial Number The serial number of the physical media that was processed.
Device ID

A unique ID of the device, whose value can be used for USB whitelisting.

Partition
Count

The number of partitions on the device.

Disk Usage

The amount of space used / the total size of the drive.
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Data Item

Description

Scanning
System

The machine name of the Metadefender Kiosk system where the
processing was done.

Full Media
Processed

Indicates whether all of the files on the media were processed.

Total Files
Scanned

The total number of files scanned by Metadefender Core.

Total Files
Processed

The total number of files processed by Metadefender Kiosk.

Blocked Files

Section that includes a summary of the files blocked by the profiles defined
in Metadefender Core.

Mismatched

The number of files detected as a file type mismatch.

Blocked File
Types

The number of files blocked as a result of the file type filtering policy.

Password
Protected

The number of files skipped because they were password protected and/or
the password was not provided for an archive.

Potentially
Vulnerable
File

The number of files that have a known vulnerability. (detection available
only in Core V4)

Noncompliant
Archives

The number of archive files that exceeded limits specified in the archive
handling policy.

Threats

The number of files blocked because Metadefender Core detected a nonclean result.

Error
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Data Item

Description
The number of files that failed to scan either because one or more engines
did not finish scanning them successfully or errors communicating with
Metadefender Core.

Failed to
Sanitize

The number of files that failed data sanitization.

Blocked
The number of files blocked because Metadefender Core detected a nonActions Taken clean result.
Converted

The number of files sanitized by Metadefender Core.

Quarantined

The number of files quarantined by Metadefender Kiosk.

Deleted

The number of files deleted by Metadefender Kiosk.

Post Action
Ran

The number of files processed by the post action script defined in
Metadefender Kiosk

Copied To
Media

The number of files copied to another device.

Copied To
Directory

The number of files copied to another location.

Copied To
SFT Server

The number of files copied to a Metadefender Secure File Transfer server.

Moved To
Media

The number of files moved to another device.

Moved To
Directory

The number of files that were moved to another location.

The number of files moved to a Metadefender Secure File Transfer server.
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Data Item

Description

Moved To
SFT Server
Copied to
[media,
directory,
SFT Server]

The location where files were copied.

Moved to
[media,
directory,
SFT Server]

The location where files were moved.

Allowed
Section that includes a summary of the actions taken on allowed files. The
Actions Taken descriptions are the same as those described above for blocked files.

Skipped Files

The number of files skipped when scanning by Metadefender Core because
of the policy set in the Core profile.

File Type
Totals

The number of files of each file type that were included in the processing
session.

Threats

The list of files detected as threats during the session. Each file will have
the PATH, SHA-256, THREAT NAME (if applicable) and SCAN RESULT
listed.

Deleted Files

The list of files removed during processing. Each file will have the PATH
and SHA-256 listed.

Quarantine
Failed Files

The list of files quarantined during processing. Each file will have the PATH
and SHA-256 listed.
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Data Item

Description

Password
Protected
Files

The list of files included in the process that were password protected. Each
file will have the PATH and SHA-256 listed.

Potentially
Vulnerable
Files

The list of files that contain a vulnerability. Each file will have the PATH and
SHA-256 listed.

Noncompliant
Archives

The list of archives included in the process that exceeded archive handling
limits. Each file will have the PATH, SHA-256 and REASON listed

Errors Process Files

The list of files that failed to scan by Metadefender Core. Each file will have
the PATH, SHA-256 and REASON listed.

Failed To
Quarantine
Files

The list of files that could not be quarantined.

Skipped Files

The list of files that were configured to be skipped from being scanned by
Metadefender Core. Each file will have the PATH and SHA-256 listed.

File Type
Analysis
Results

The list of files where the detected file content type did not match the file
extension. Each file will have the PATH, SHA-256, SUGGESTED
EXTENSION and DETECTED FILE TYPE listed.

Blocked File
Types

The list of files whose file type was configured to be blocked. Each file will
have the PATH, SHA-256, SUGGESTED EXTENSION and DETECTED
FILE TYPE listed

Files Failed
SHA-256
Verification

The list of files that failed SHA-256 verification during copy/move (if SHA256 Verification was enabled). Each file will have the PATH and SHA-256
listed.

Files Failed
to be
Sanitized

The list of files that failed to be sanitized. Each file will have the PATH
listed.
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Data Item

Description

Allowed Files

The list of allowed files in the session. Each file will have the PATH and
SHA-256 listed.

Path

The relative path to the given file.

SHA-256

The hash value of the given file.

Threat Name

The name of the infection for the given file.

Scan Result

The scan result of the detected file threat

Suggested
Extension

The expected file extension based on the detected content type of the file.

Detected File
Type

The detected content type of the file.

Reason

The reason the file has been included in the current list.

Example of a Scan Log File
OPSWAT - METADEFENDER KIOSK SCAN RESULTS
What is the ID of the media you will be scanning?: GX3419
What is the source of the files on this media?: 3rd Party Vendor
What is your name?: Metadefender Kiosk User
User ID: opswat\sampleuser
Profile: Default
Session ID: F624AA1F-BFF1-4501-A8F7-75DAC4C9EF2A
PROCESSING FINISHED SUCCESSFULLY
Process Start Time: 2016-07-23 10:54:09
Process Finish Time: 2016-07-23 10:54:35
Metadefender Core Version: 3.11.1.27535
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Metadefender Kiosk Version: 3.3.1.27740
Device Information
Manufacturer: (Standard disk drives)
Model: SCSIDISK SCSI_DISK_1234 USB Device
Serial Number: 12102314434D
Device ID: USBSTOR\DISK&VEN_SCSIDISK&PROD_SCSI_DISK_1234&REV_1.
00\12102314434D&0
Media Type: USB Device
Partition Count: 1
Disk Usage: 30.8MB / 1.8GB
Scanning System: METADEFENDER-KIOSK
Full Media Processed: YES
Total Files Scanned: 19
Total Files Processed: 20
Blocked Files
- Mismatched: 0
- Blocked File Types: 0
- Password Protected: 1
- Noncompliant Archives: 1
- Threats: 5
- Failed To Scan: 0
Blocked Actions Taken
- Converted: 0
- Quarantined: 0
- Deleted: 0
- Post Action Ran: 0
- Copied To Media: 6
- Copied To Directory: 0
- Copied To SFT Server: 0
- Moved To Media: 0
- Moved To Directory: 0
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- Moved To SFT Server: 0
- Copied to directory: C:\Kiosk\Sessions\F624AA1F-BFF1-4501-A8F775DAC4C9EF2A\blocked
Allowed Actions Taken
- Converted: 2
- Post Action Ran: 0
- Copied To Media: 16
- Copied To Directory: 0
- Copied To SFT Server: 0
- Moved To Media: 0
- Moved To Directory: 0
- Moved To SFT Server: 0
- Copied to directory: C:\Kiosk\Sessions\F624AA1F-BFF1-4501-A8F7-75DAC4C9EF2A\allowed
Skipped Files: 0
File Type Totals
bmp: 1
doc: 1
docm/docx: 2
exe/dll: 1
gif: 1
htm/html: 1
jpg/jpeg: 1
pdf/ai: 1
png: 2
pps/ppt: 1
pptm/pptx/ppsx: 1
tif/tiff: 1
xls/xla: 1
xlsm/xlsx: 1
zip/jar: 4
_______________________________________________________________________
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THREATS
1. PATH: F:\Samples\eicar_com.zip
SHA-256: F3F0C45B82514D6B2AB45F988288249AD73F3591BBD51CD
9302815EDE372143D
THREAT NAME: Eicar-Test-Signature
SCAN RESULT: Dirty
----------------------------------------------------------------------2. PATH: F:\Samples\eicarcom2.zip
SHA-256: 4FDABC19CFC54D84153389CEB1F75461606275207E24B60
04B74314200AB201B
THREAT NAME: Eicar-Test-Signature
SCAN RESULT: Dirty
----------------------------------------------------------------------3. PATH: F:\Samples\Sample Embedded.docx
SHA-256: 89309D4B57F87D6A25FA6053032B9E2106C41D146C9F8A3
C2BC56DE736619A2A
THREAT NAME: Eicar-Test-Signature
SCAN RESULT: Dirty
----------------------------------------------------------------------4. PATH: F:\Samples\Self-Extracting.exe
SHA-256: 987204377CCE14B041BDCE2B2821063711E4B4786EDFBB9
103131EE3CB57FF25
THREAT NAME: Eicar test file
SCAN RESULT: Dirty
----------------------------------------------------------------------5. PATH: F:\Samples\Sample Files.zip
SHA-256: 7FD5107BF4D2A6FA445752025163C7F3B931B52E0BE22E7
D49A65FB3AA80FD31
THREAT NAME: Eicar-Test-Signature
SCAN RESULT: Dirty
----------------------------------------------------------------------4.1.0
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_______________________________________________________________________
PASSWORD PROTECTED FILES
1. PATH: F:\Samples\File Test Set.zip
SHA-256: 1126E898787D018BE43BFF14A2AB24C605F5592654EFDA3692
821AA7E3AC9052
_______________________________________________________________________
_______________________________________________________________________

9.7. Copying Files to Another Media
If your workflow profile specifies copying scanned files to other media, you are prompted to
insert the media to which you want to copy your files. If you do not want to copy the files, click
Skip Copy to Media .
The original source media must remain connected to Metadefender Kiosk to successfully copy
the files.

If the user media is configured to be wiped before copying, a prompt will alert the user that the
destination media will be wiped.
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Select 'Continue' to have the media wiped and copy files to or 'Cancel' to be taken back to
insert another media to copy files to.

Note: If you insert an encrypted device as the media to copy to, you will be prompted to enter
the password to unlock the media before files are copied.
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10. Developer Guide
10.1. Custom Authentication Module
Metadefender Kiosk allows you to audit the users that transfer data to and from the
organization as well as to create a secure dataflow. Commonly used as a checkpoint to protect
infrastructure from the risk of removable media devices (such as USB drives, CDs/DVDs, and
other portable media), Metadefender Kiosk allows you to configure detailed content filters for
unknown removable devices brought in by employees, contractors, vendors and others.
This section provides instructions for developers who intend to build or integrate their own
authentication method of these users into Metadefender Kiosk. We recommend that you have a
strong understanding of C/C++ before reading this section.
The bundled code included in this section is a sample of how the authentication module can be
implemented. You should modify the contents in each method described in this section to
accommodate your integration needs. You can remove any additional methods in the sample
code not described in this section if not needed.
Important: Any configuration pertaining to the custom authentication module are not saved if
you uninstall and re-install Metadefender Kiosk. You must keep a copy of your module before
uninstalling and then copy it back to the same directory once your installation or upgrade is
complete.

System requirements
The system requirements for implementing custom authentication are as follows:
Metadefender Kiosk 3.2.0 or later
Visual Studio 2013 or later
NET 4.5 or later for running the Custom Authentication Sample for the sample UI

Deploying and configuring custom authentication
The steps necessary to deploy custom authentication are as follows:
1. Obtain a custom authentication template package from the OPSWAT Portal downloads.

Note: Use the template for C++ custom authentication module (vc12).
2. Implement the custom authentication interface & build the custom authentication module

(authenticationModule.dll).
3. Deploy the custom authentication module.
4. Configure Metadefender Kiosk to load and use the custom authentication.
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Configuring custom authentication
After successfully building the custom authentication module, you can configure the custom
authentication module.
1. Place the module (authenticationModule.dll) in the expected directory (e.g.,

<Metadefender Kiosk Install Directory>\Client\Authentication).
2. Open the Metadefender Kiosk Management Console, and go to the Workflows tab.
3. Go to the Configuration section.
4. Select Require user authentication, then select Custom Authentication, and click Apply .

Note: If Custom Authentication does not appear, the authentication module is either
named incorrectly or not in the expected directory.

Understanding C++ code in the custom authentication template
The following section describes the C++ code in the custom authentication template.

Init
This is the first method called. It allows you to initialize your authentication module.

init
int Init
(
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bool * showUI
)

Arguments
Argument

Description

showUI

Output indicates if the authentication module has a UI to display to the user.
True: Has a UI.
False: Has no UI.

Return value
Value

Description

0

The module initialized correctly.

Non-zero

Initialization failed and the module cannot be used.

Verify
This method initiates the authentication process to run. The return value has nothing to do with
if the user is authenticated or not. Instead, it indicates if the authentication process was
successful or not.

init
int Verify
(
wchar_t ** verifiedID wchar_t * desktopName wchar_t **
password
)
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Arguments
Argument

Description

Notes

verifiedID

The ID associated with the user that successfully
authenticated. If a user is denied, then this is empty.

Implementer
must allocate
the memory
required.

desktopName Metadefender Kiosk uses a second desktop for security
reasons. If your authentication process has a UI to display
to the user, this will indicate the desktop in which your
authentication process will be launched.

Disregard if
your
authentication
process does
not require a
UI.

password

Implementer
must allocate
the memory
required.

The verified user’s credentials which allows Metadefender
Kiosk to handle post processing permissions. If you don't
want Metadefender Kiosk to have the user’s permissions,
leave this empty.

Note: From 3.5.0, if verifiedID is empty, Guest profile will be used.

Return value
Value

Description

0

Verification ran successfully.

Non-zero

Verification failed to run.

Denit
This method is called when Metadefender Kiosk is shut down. Any resources acquired by your
module should be released and any unsaved data should be stored.

init
int Deinit
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(
)

Arguments
No arguments are required for this function.

Cancel
This method is called when the user tries to cancels while verification is running.
int Cancel
(
)

Arguments
No arguments are required for this function.

Return value
Value

Description

0

The cancel request was accepted.

Non-zero

The cancel request was denied.

FreeString
This method is called to free allocated memory for wchar_t **. Metadefender Kiosk calls this
function when finished with the values allocated by your functionality.

init
int FreeString
(
wchar_t ** stringToFree
)
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Arguments
Argument

Description

stringToFree Double pointer to
wchar_t

Notes
This function must be de-allocated in the same way that
memory is allocated.

Return value
Value

Description

0

The allocated memory was successfully released.

Non-zero

The allocated memory failed to be released.

Using the custom authentication tester
The custom authentication testing package includes a file called TestCustomAuthentication.exe
that lets you test and troubleshoot your authentication module before using it with
Metadefender Kiosk.
TestCustomAuthentication.exe behaves similarly to the component Metadefender Kiosk uses to
load the authentication module. Since Metadefender Kiosk runs under a SYSTEM context, you
should run the authentication module under SYSTEM as well. Attempting to run the
authentication module under any other user may invalidate the module's results. You must run
TestCustomAuthenticationModule.exe under SYSTEM to properly load authenticationModule.
dll and test the methods.
You can use Windows Sysinternals to run the tool as SYSTEM.
To run the custom authentication tester:
1. Download PsExec.
2. Open a command prompt (as an administrator) to where PsExec is installed and enter

"PsExec.exe -s cmd.exe"
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3. Navigate to the <Metadefender Kiosk Install Directory>\Client\Authentication directory.
4. Run TestCustomAuthentication.exe. At all points of method testing, the tester pauses

and allows you to control when to move on to the next test.
5. A PASSED or FAILED result appears.

pcProx Plus RFID Reader Custom Authentication Module
Overview of Module
Required Components
Configuration
Metadefender Kiosk Configuration
Reader Configuration
pcProxConfig Installation
Adding pcProx Custom Authentication Module to Metadefender Kiosk
Using the pcProx Custom Authentication Module
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Overview of Module
This documentation describes usage of the pcProx Plus RFID Reader custom authentication
module. This authentication module can be used with any version of Metadefender Kiosk
version 3.2.0 or later to allow RFID cards to be used for Metadefender Kiosk authentication.

Required Components
Installed Metadefender Kiosk system (version 3.2.0 or later)
Installer available on OPSWAT's portal at https://portal.opswat.com/en/productcategories/metadefender-kiosk
pcProx Plus RFID Reader
https://www.rfideas.com/support/product-support/pcprox-plus
pcProxConfig reader configuration tool
Download available at https://www.rfideas.com/support/product-support/pcproxplus
Documentation available at https://www.rfideas.com/files/downloads/manuals
/Enroll_Plus_Wiegand_Manual.pdf
pcProx Plus RFID Reader Custom Authentication Module
Compiled binaries and source available on the OPSWAT Portal at https://portal.
opswat.com/en/content/metadefender-kiosk-custom-authentication-modulesample-code

Configuration
Metadefender Kiosk Configuration
If Metadefender Kiosk has not already been installed on the system, install it using the installer
available on the OPSWAT Portal at https://portal.opswat.com/en/product-categories
/metadefender-kiosk. Follow the installation steps in the Metadefender Kiosk documentation.

Reader Configuration
pcProxConfig Installation
1. Download the pcProxConfig installer from https://www.rfideas.com/support/product-

support/pcprox-plus
2. Run the installer to install the pcProxConfig configuration tool

3.
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3. Connect the pcProx reader to the Metadefender Kiosk system and wait for the driver to

be installed. The LED on the reader will turn red
4. Launch the pcProxConfig tool, the device should be automatically detected

a.
b. If the reader is not automatically detected you can click on the 'Connect' button to

detect the reader
c. The reader should be shown in the device list
5. Select 'Card Analyzer' from the menu

a.
6. Click 'Learn Card'
a. Click Start Scan, and when prompted put the RFID card that you want the device

to learn on the scanner. The card will need to stay on the reader until the scanning
is complete.
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b.

c.
7. Click the 'Auto Config>' button
8. Select the Configuration # to set and click the 'Write' button

a.

9.
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9. After the configuration has been written click 'Exit' to close the Card Analyzer dialog or

click the 'Learn Card' button to learn another card type
10. Confirm that the configuration has the 'High priority' checkbox selected

a.
b. If two configurations are saved make sure this is selected for both
11. Select the 'Format' tab. On the 'Data Format' subtab do the following.
a. Confirm the 'Send ID' checkbox is selected
b. OPSWAT recommends that the 'Send FAC' checkbox is also selected

c.
12. On the 'Delimiters' subtab, do the following
a. Confirm the Pre-data delimiter is set to <NONE>
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b.
c. Confirm the Post-data delimiter is set to <NONE>
d. Confirm the Termination Keystroke is set to <ENTER>

e.
13. Click the 'Write Active' button to save the configuration. If there are two configurations set

this needs to be done for both configurations.
14. Test the configuration by opening the Notepad application and scanning a card. The card

ID should be written into Notepad.

Adding pcProx Custom Authentication Module to Metadefender Kiosk
1. Copy the following files from the custom authentication module download package into

your C:\Program Files (x86)\OPSWAT\Metadefender Kiosk\Client\Authentication
directory
a. authenticationModule.dll
b. CustomAuthExample.exe
c.
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c. omConfig_CAM.ini
d. db
2. If you would like to restrict users to the RFID cards that are listed in the database
a. Set the property validate_ID=1 in omConfig_CAM.ini
b. Open the 'db' file with a text editor, such as Notepad. Update/add the valid card IDs

(can be read by pcProxConfig tool, step 14) with the corresponding user names in
the format <Card ID>:<Name>. Only card IDs that are listed in this file can be used
for authentication.
3. In the Metadefender Kiosk Management Console, enable Custom Authentication on the

'Workflows' configuration page

a.
b. Click the 'Apply' button

Using the pcProx Custom Authentication Module
1. Users will be prompted to scan their RFID badge

a.
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2. The ID from the card will be saved as the user ID for the session
a. In the session log viewable through the Management Console

i.
b. On the scan receipt
c. In the saved text log file

10.4 Quarantine Manager Command Line Interface
You can use the Metadefender Kiosk Quarantine Manager CLI (omsQMCLI.exe) to browse and
manage quarantines. The size of the Metadefender Kiosk quarantine is limited to 100 MB.

Help
Syntax: help
This function prints the available command line options.

Quarantine file
Syntax: quarantine <file path> <threat name>
This command adds the specified file to the quarantine database under the given threat name.

Delete quarantine
Syntax: delete <file path>
This command permanently deletes a file which has been quarantined.
Note: Disk space will be reused without returning to the OS.

Restore quarantine
Syntax: restore <quarantine ID> [target directory]
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This command restores a quarantined file back to the original location. If a file already exists
with the same name, a number will be appended to the file name. You can override the location
the file is to be restored to by specifying the target directory.

Browse quarantine
Syntax: list [<minimum number of quarantines to display>]
This command lists quarantined files.
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11. Recommended Deployment of Metadefender Kiosk(s)
in Secure Facilities
Overview
OPSWAT's Metadefender Kiosk product is deployed by organizations to scan portable media
and detect and prevent threats contained on such media and prevent their introduction to
secure networks and systems. The intention of this document is to outline OPSWAT's
recommended deployment for Metadefender Kiosk systems within a high security environment.
Specifically, this covers the deployment of Metadefender Kiosk systems to meet the
requirements for handling digital media.

Recommended Deployment Diagram

Metadefender Kiosk Deployment Options
For each deployment aspect below, OPSWAT has recommendations for different deployment
options. In many cases, there are multiple deployment options that have trade-offs between
security, usability, cost, or all three. When different options are available an attempt is made to
describe the trade-offs between the different options.

Distributed vs Standalone Deployment Model
Metadefender Kiosk and Metadefender Core can be installed either on the same system or on
separate systems that are accessible over a network. Although both options are secure,
OPSWAT recommends considering the following advantages of each.

Advantages of a Distributed Deployment Model
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Advantages of a Distributed Deployment Model
1. The Metadefender Kiosk system can be protected by a system imaging product (see the

System Imaging section below) without the loss of anti-malware definitions (see the
Upgrading Anti-malware Engine Definitions section below) that have been applied to the
Metadefender Core component
2. Separation of the Metadefender Kiosk and Metadefender Core components means that

compromising the Metadefender Kiosk system does not compromise the Metadefender
Core system or vice versa
3. If multiple Metadefender Kiosks are using the same Metadefender Core the anti-malware

definitions only need to be updated on the Metadefender Core server. This allows the
definitions to be updated on a more frequent basis which increases the security against
new outbreaks and zero-day attacks
4. Metadefender Core servers can be located in a different physical location than the

Metadefender Kiosk system. This has multiple advantages
a. The Metadefender Core system can be located in a more easily accessible area

and thus be updated with anti-malware definition updates more frequently
b. If the Metadefender Kiosk system is physically compromised it does not affect the

Metadefender Core system
5. Metadefender Core server can be deployed on Linux, reducing the likelihood the same

threat could compromise both the Kiosk and Core systems.

Advantages of a Standalone Deployment Model
1. No networking infrastructure or configuration is required
2. Kiosks can be relocated without any additional modifications

Network Traffic Restrictions
These recommendations are only applicable if the Metadefender Kiosk systems are networked.
The following functionality of Metadefender Core and Metadefender Kiosk require network
access to other systems
Remote configuration of Metadefender Core and Kiosk
Application of antimalware engine definition updates to Metadefender Core
Changes to workflows
Other configuration change
Distributed Deployment of Metadefender Core and Kiosk
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Transfer of files to be scanned
Retrieval of scan results
Post Scan File Handling
Upload of files from Metadefender Kiosk to Metadefender SFT (if configured as a
file handling option in workflows)
Copying of files from Metadefender Kiosk to a network path (if configured as a file
handling option in workflows)
OPSWAT recommends restricting the allowed traffic to only that necessary for the functionality
needed in a deployment. OPSWAT recommends using a product designed for this purpose to
tightly restrict the traffic that is allowed. OPSWAT can provide recommendations on specific
products that have been tested with Metadefender for compatibility. If such a device is not
used, OPSWAT recommends restricting network traffic to only the ports required for operation
of the Metadefender Kiosk systems using Windows Firewall as well as restricting traffic to
specific trusted MAC addresses.

System Imaging
For the most security, OPSWAT recommends using a product capable of restoring Kiosk
images to a known good point. Metadefender Kiosk provides the option to restart the kiosk after
each scanning session. When combined with a system restore product, this is the most secure
configuration setting. If business requirements make restarting the kiosk after each session
unfeasible, a scheduled task can be set to restart the kiosk systems on a regular basis (e.g.
every night) so that they are restored at that time. OPSWAT can recommend vendors that
provide system restore functionality.
If a system restore product is installed on the kiosk, all configuration changes will be lost
every time the system is restarted. If configuration changes are needed on the system,
the system must first be put into an 'configurable' state for the changes to be made and
then a new image taken with the updated configuration. This is also true for upgrades to
newer versions of Metadefender Kiosk or any patches that have been applied to the
software.
If Metadefender Core is installed on the same system as Metadefender Kiosk all updates
will be lost upon system restore. This includes all antimalware engine definition updates
that have been applied. See the section on the advantages and disadvantages of
choosing a distributed vs standalone deployment model
All scan logs that are stored on the system will be lost upon system restore. To maintain
logs, Metadefender Kiosk must be configured to save session logs to another system.
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Metadefender Kiosk Hardening
OPSWAT recommends following the instructions in the Metadefender Kiosk user guide to
harden the Metadefender Kiosk systems.

Maintenance Policy
Updating Antimalware Engine Definitions
1. Metadefender Core antimalware engine definitions should be updated by following the

instructions in the Metadefender Core documentation
2. For downloading offline definition updates, OPSWAT recommends using the

Metadefender Update Downloader
3. OPSWAT recommends updating the antimalware engine definitions as often as is

possible, preferably daily

Upgrading Metadefender
1. Metadefender Core and Metadefender Kiosk should be upgraded by following the

upgrade instructions in the product documentation
2. OPSWAT recommends that when possible all deployments should be on the latest

versions of Metadefender Core and Metadefender Kiosk. For more information on
OPSWAT's support policy for specific versions of Metadefender Core and Kiosk please
refer to OPSWAT's Metadefender support Policy
3. When systems are upgraded it is recommended that the configuration settings from the

previous installation are exported and archived so that they are available in case systems
need to be restored to a previous version
4. OPSWAT recommends always upgrading both Metadefender Core and Metadefender

Kiosk at the same time

Configuration Options
User Authentication and Metadefender Kiosk Workflows
Metadefender Kiosk enables authentication of users before starting a scanning session.
OPSWAT recommends enabling user authentication for the following reasons.
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Identification of which user scanned each piece of media that was scanned by
Metadefender Kiosk for audit purposes
Usage of different user profiles for different groups of users (see section on Multiple
User Profiles)
Metadefender Kiosk supports the use of custom authentication modules, which allow each
organization to integrate their authentication method (e.g. RFID card, badge scanner, IC card,
etc) with their Metadefender Kiosk. This allows an organization to link scan sessions to their
existing authentication systems. Depending on the authentication system used, a custom
authentication module may have to be developed for deployment. Contact OPSWAT for more
information on what a specific system would require.

Multiple User Workflow Profiles
OPSWAT recommends configuring multiple user workflow profiles to process files from different
users. Each workflow should be configured to restrict the types of files to the minimum those
users are expected to need to complete their jobs. File types that are more risky (e.g. EXEs or
Archive files) should be limited to the users that are expected to bring in those types of files and
need them to complete their work and should be blocked for all other users.

Authentication and Metadefender Secure File Transfer (SFT)
If files are being uploaded to a Metadefender SFT server after scanning there are two options
for uploading the files
1. Upload to an SFT user account - This is an option if the user credentials are available to

the Metadefender Kiosk system. This would most likely be the case if Metadefender
Kiosk and Metadefender SFT are both on the same network and are using the same
Active Directory server for authentication.
2. Upload to an SFT guest user account - This is an option to create a guest user account

that is used for a specific file upload. This can be used when either user credentials are
not available to Metadefender Kiosk or there are guest users scanning files on the
Metadefender Kiosk.

Data Sanitization
Data sanitization is the process of removing potentially dangerous objects within files or
modifying the files to neutralize threats, even if they are not detected by any antimalware
products. Metadefender Core's data sanitization technology allows administrators to specify
that certain types of files are sanitized even if no threat is detected. Although this results in
greater security and a reduction in the risk to unknown threats, there is a tradeoff in that the
usability of sanitized files is sometimes less than the original file.
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For the highest level of security, OPSWAT recommends that data sanitization is applied
to all document and image types that are supported unless the potential loss of usability
in those files is too great for business reasons.
Note that a sanitized file will have a different hash than the original file, even if there was no
threat in the original file.

Post-Scan File Handling
OPSWAT recommends that files are copied to a new location after scanning so that original
media does not need to be used in a secure area. Files should be restricted to those allowed by
the defined security workflow. Metadefender Kiosk offers multiple options for moving files to a
new location after scanning.

Options for Networked Environments
The most secure option if the Metadefender Kiosk system is on a network is to upload the files
to a Metadefender Secure File Transfer server. The advantages of uploading to Metadefender
SFT is that the files can be uploaded to a specific user's account or a guest account, and
access is limited to that user. All file uploads and downloads are tracked, and an audit log is
available for compliance officers to see when files were uploaded and downloaded from the
server. This can help to track when files are accessed in a network and by whom.
If Metadefender SFT is not used, files can also be copied to a network share into a directory
tied to the user who authenticated on the Metadefender Kiosk system.

Option for Non-networked Environments
If the Metadefender Kiosk system is not deployed on a network OPSWAT recommends using
the functionality to copy clean files to user provided media, allowing original media to not be
used on the secure network. OPSWAT would recommend either copying to pre-approved
media that is only used in the secure network or to static media, such as CDRs. If copied to preapproved rewritable media, such as USB drives, OPSWAT recommends a policy to wipe that
media after use and before the next time the media is used as the destination media.
Metadefender Kiosk's wipe functionality can be used for this purpose.

Session Logging
Metadefender Kiosk Supports three types of logging of individual scan sessions. All three can
be enabled or disabled independently of each other.

1.
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1. Save session log to a text file - Saves a text log for each session to the default log

directory or a directory specified by the administrator, however if the files are saved
locally they will not be retained if the system is restored as recommended in the System
Restore section above. To retain these session logs they should be pushed to a
centralized network location.
2. Save session log to scanned media - Saves the text log for a session to the media that

was scanned. This allows a record of the scan to be saved on the media that was
scanned, however a file will not be written if the original media is read-only.
3. Send session log to e-mail recipient - This allows all scan logs to be collected into a

single e-mail account, however it does require that the Metadefender system has access
to a mail server to send the e-mail.
If logs from the Metadefender systems are required outside of the secure network, OPSWAT
recommends the use of a data diode to transfer files out of the network. OPSWAT can
recommend different vendors to meet this need upon request.

Common Questions about Metadefender Kiosk
1. How many Metadefender Kiosk systems are needed in a deployment?
a. We believe that the appropriate number of units would be the number required to

give end users a chance to scan media however and wherever they are bringing it
into a secure area. So, if there are three entrances a kiosk can be located at each
entrance. If employees and/or visitors are also expected to scan media that is
already within the secure area then a kiosk should also be in a location that is
convenient for users to access within the secure area.
2. What are the recommended physical locations for Metadefender Kiosk systems to

ensure steady availability to all end-users?
a. We recommend that Metadefender Kiosk stations are located at all entrances to

secure areas, and that users are required to scan any portable media before
bringing them into secure areas.
3. Which organization functional unit should be the owner of the Metadefender Kiosk

systems (to maintain, update, …etc)?
a. The appropriate department should be the one that is able to handle definition and

software updates to the Metadefender Kiosk systems. The necessary skills include
basic Windows operating system knowledge as well as comfort with configuration
and deployment of secure networks.
4. Do you recommend deploying Metadefender Kiosk in a standalone or distributed

environment? What are the pros and cons of different deployment options?
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4.

a. A majority of our current customers have deployed Metadefender Kiosk systems as

standalone systems not connected to any network. Although this is a secure
deployment option, we think that the most secure solution is to deploy
Metadefender Kiosks on an isolated network, with multiple Metadefender Kiosk
systems using a shared backend Metadefender Core server. The advantages of
this deployment model are the following:
i. The Metadefender Core server can be located in a central location that is

physically easier to access to apply engine definition updates
ii. The Metadefender Core server can be on a high performance server so that

better scanning performance can be achieved versus standalone systems
iii. A single centralized Metadefender Core server can have more scanning

engines than multiple standalone Metadefender Core servers at the same
total cost
iv. The Metadefender Kiosk systems can be restored to a known ‘clean’ state if

necessary without losing engine definitions that have been applied
b. The disadvantage of going with a distributed deployment is maintenance of the

network and the existence of the central Metadefender Core server but we
generally feel that the benefits listed above outweigh the additional costs
5. How frequent should antimalware engine definitions be updated?
a. We recommend updating the engine definitions as often as is possible, preferably

once a day if it is feasible. The ability to update virus definitions more frequently is
a major advantage to having a distributed deployment model with a central
Metadefender Core server.
6. How do you recommend laptops or tablets are scanned for threats?
a. Devices such as laptops or tablets can be scanned with our Metadefender Client

product on an isolated network. This client can be run on the device either when
the system is already running or can be included on a 'boot' or 'live' CD or USB that
is used to boot the system into a limited operating system.
7. Can Metadefender Kiosk detect BadUSB?
a. With BadUSB based attacks, the USB device has been modified to act as a

different type of device (e.g. a keyboard or other peripheral) instead of a flash USB
drive. Since this is done at a firmware level, there is no way for the system, and the
Metadefender Kiosk software, to know that is is anything besides the type of device
it is identifying itself as, however just as the Metadefender Kiosk UI is hardened
against being compromised by a physical keyboard it would protect against a ‘fake’
keyboard or other input device that a BadUSB device is pretending to be.
8. Does Metadefender Kiosk provide any protection when the kiosk UI is not running?
a.
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8.
a. If the Metadefender Kiosk software is not running there is no additional protection

on the system provided by Metadefender Kiosk.
9. Is it possible for malicious code to compromise the Kiosk UI?
a. OPSWAT is not aware of any way that a client can be compromised.
10. If the Kiosk UI is compromised is there a way for the Server to be compromised as

well?
a. If the Kiosk were to be compromised, it does have system or network access to the

server. What OPSWAT would recommend as the most secure deployment option
would be have Metadefender Kiosk and Metadefender Core on separate systems
on the same isolated network, and a device restricting network traffic between the
Kiosk and the Core server to restrict traffic between the Kiosk and the server to
only the traffic necessary for scanning. OPSWAT can recommend devices to
provide this functionality. In addition, the Metadefender Core server can be
deployed on Linux, reducing the likelihood the same threat could compromise both
the Kiosk and Core systems.
11. Is it possible for malicious code to be written to the Metadefender Core server and

compromise the Server?
a. All files are written to the temporary directory, which can optionally be set to the

RAM drive, and then removed immediately after scanning so they will not remain
on the server.
12. If multiple Metadefender Kiosk systems are deployed on the same isolated network

could a compromised Metadefender Kiosk system compromise other
Metadefender Kiosk systems?
a. OPSWAT is not aware of any way that a Metadefender Kiosk system could

compromise another Metadefender Kiosk system on the same network. However,
for additional security, having a device that restricts traffic to only that required for
scanning files can be added between the Metadefender Kiosk system and the
network. OPSWAT can recommend devices that provide this functionality.
13. If a Metadefender Kiosk system is compromised could it infect media being

scanned?
a. OPSWAT is not aware of any way the Kiosk could be compromised to act in this

fashion, however for additional security the Kiosk could be restored to a known
‘clean’ state after each scanning session. OPSWAT can provide recommendations
on tools that can be used to provide this functionality.
14. If a Metadefender Core server is compromised could it infect media being scanned?
a. The Metadefender Core server does not interact with the media being scanned in

any way.
15.
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15. What provisions/safeguards are in place to assure that an infected file is not

skipped during a scan session either because a scan was cancelled or because a
user did not select that file to be scanned?
a. If any files are not scanned on the media, either because the user cancels a scan

or because they browse to select the files that are to be scanned, within the scan
session log is a notification that the entire media was not scanned. OPSWAT also
recommends that the functionality of copying to user provided media or to a
Metadefender Secure File Transfer server is used to ensure only files that have
been scanned without any threats detected are used on a secure network.
16. Is there any known instance where a Metadefender Kiosk system has been

compromised in the past?
a. OPSWAT is not aware of any deployed Metadefender Kiosk system that has been

compromised.
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12. Release Notes
New features
Support for additional models of encrypted USB drives
Ironkey S1000
Ironkey D300
Kingston DataTraveler Vault Privacy 3.0
Kingston DataTraveler 2000
Kingston DataTraveler 4000
Answers to user questions can be used in the path specified for post scan file handling
When copying blocked files, administrators have the option of only copying files that
have been sanitized.

Other changes
The Metadefender Kiosk Management Console now has a default password ('admin')
after installation.
Cancelling a scan will cancel scans in progress on the Metadefender Core server
Kiosk will retry scans that initially fail on the Metadefender Core server
Improvements in the Japanese language keyboard
Language keyboards can be disabled from the Kiosk UI

12.1. Archived Kiosk Release Notes
Version 4.0.2
=============

New features
------------ Metadefender Kiosk can be configured to check for existing scan results before sending a file
to Metadefender Core
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Other changes
------------- The Browse and Scan All options will not be displayed in the Kiosk UI if they are disabled
- Media wipes are now logged as sessions
- Media manifests are uploaded with files that are copied to a Metadefender SFT server
- Vulnerability details are displayed if Metadefender Core has the Metadefender Vulnerability
engine enabled

Version 4.0.1
=============

New features
------------ Signed scan manifests can be written to processed media (requires Metadefender Core 4.8.0
or later)

Other changes
------------- Improvements in uploading files to a Metadefender SFT server
- Session scan logs are included in a configuration export

Version 4.0.0
=============

New features
------------ New Kiosk user interface
- Optional 'Disclaimer' Screen in Kiosk workflow
- Support for user selected language

Other changes
------------- Re-implementation of drive wipe functionality
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- Move to new licensing mechanism
- 32-bit operating systems are no longer supported
- Minimum required version of Metadefender Core is 4.7.2
- Configuration can not be imported from versions prior to 4.0.0

Version 3.4.6
=============

New features
------------ None

Other changes
------------- Fixed issue where Kiosk sometimes didn't launch after system restart
- Minor bug fixes

Version 3.4.5
=============

New features
------------ Alert dialog shown to the user when a non-memory USB device is inserted
- Devices can be limited to those whitelisted by device ID

Other changes
------------- The only Metadefender Kiosk workflows included by default will be the 'Default' and 'Guest'
workflows
- Mechanism to retrieve device serial IDs has been improved

Version 3.4.4
=============

New features
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New features
------------ None

Other changes
------------- Metadefender Kiosk will now attempt to detect a second media if the first one detected fails
- Error message shown when files can not be removed by Metadefender Kiosk

Version 3.4.3
=============

New features
------------ Support for USB Flash Security encrypted drives
- Option to whitelist files larger than a specified size
- Allow administrator to disable 'Process All' option

Other changes
------------- Addressed issue in using Kiosk over HTTPS
- Better handling of scan results from Metadefender Core 4.x
- System files on Bitlocker encrypted devices can optionally be excluded from scanning

Version 3.4.2
=============

New features
------------ Metadefender Kiosk can now be configured to abort scans as soon as a blocked file is found
- Multiple Metadefender Core servers can be defined for redundancy
- Support for wiping encrypted USBs
- Alert sound can be customized
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Other changes
------------- Better reporting of mismatched files that are found within archives
- SMTP settings for emailed session reports are now configured globally
- Estonian keyboard layout is now supported for the onscreen keyboard
- Options for handling multiple partitions have been simplified to either block devices with
multiple partitions or scan all available partitions

Version 3.4.1
=============

New features
------------ None

Other changes
------------- Kiosk user will now be prompted to confirm before destination media is wiped before files are
copied to it

Version 3.4.0
=============

New features
------------ Each Metadefender Kiosk workflow specifies a specific Metadefender Core workflow or rule to
use
- Files identified as potentially vulnerable by Metadefender Core's vulnerability engine are
shown in the scan results
- Metadefender Kiosk will now scan the boot sector of any media

Other changes
-------------
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- The Metadefender Kiosk session log page user interface has been updated
- Potential security vulnerability with Ctrl-L key combination has been closed
- Better handling of McAfee encrypted USB devices
- Requires Metadefender Core 3.12.4 or later

Version 3.3.6
=============

New features
------------ Built in user authentication now supports remote Active Directory authentication. Note that for
remote Active Directory authentication provided user credentials are not used when files are
copied as a post action.

Other changes
------------- Metadefender Kiosk will validate SSL certificates when using HTTPS to communicate to the
Metadefender Core server. If Metadefender Core is using a self-signed certificate, this
certificate must be installed on the Metadefender Kiosk machine, otherwise validation will fail.
- The Metadefender Kiosk UI will reset after the scanned media has been removed when at the
scan results page

Version 3.3.5
=============

New features
------------ Encrypted drives can now be used as the "Copy To" destination
- Drives that are being copied to can now be wiped before files are copied

Other changes
------------- Server settings for e-mail notifications are now configured in Metadefender Kiosk instead of in
Metadefender Core

Version 3.3.4
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Version 3.3.4
=============

New features
------------ Compatible with Metadefender Core 4.4 and later versions
- Support for Kanguru 2000 and 3000 encrypted USBs
- More flexibility allowed in the destination directory when "Copy To" post action is enabled
- Scan session log can be saved as a PDF

Other changes
------------- High security workflow included by default in installation
- Kiosk UI now scales to higher resolutions
- Count of files sent to a Metadefender Secure File Transfer server added to Management
Console dashboard

Version 3.3.3
=============

New features
------------ Non-guest Metadefender Kiosk profiles can now upload to Metadefender SFT guest accounts.

Other changes
------------- Updated onscreen Japanese keyboard
- Metadefender Kiosk can now be used with a Metadefender Core server that has an API key
set.
- Fixed bug where files on read-only media that are sanitized were not getting copied as part of
the file handling part of the workflow.
- Several hotkeys are now automatically disabled when the UI is running
- Additional minor bug fixes.
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Version 3.3.2
=============

New features
------------ Scan reports can now be sent by e-mail after the scanning session is complete.
- The file upload chunk size for uploading files to a Metadefender SFT server is now
configurable.

Other changes
------------- The sender e-mail address is no longer required when uploading files to a Metadefender SFT
server.
- Additional strings have been added to the Kiosk UI and can be modified through the
Management Console.
- The encryption method for passwords saved in the Metadefender Kiosk configuration has
changed. Importing configuration from versions prior to Metadefender Kiosk 3.3.2 will not import
passwords.

Version 3.3.1
=============

New features
------------ None

Other changes
------------- Better cancellation of a scan in progress
- Fixed issue when browsing blank media
- Correct detection of unencrypted Kanguru devices
- Database and Windows events can be viewed through the Management Console
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Version 3.3.0
=============

New features
------------ The name of the product is now Metadefender Kiosk.
- Administrators have the option to restrict access to domain users when Windows
authentication is enabled.

Other changes
------------- Fixed bug in importing saved configuration
- IIS Express component has been upgraded to version 8.0

Version 3.2.0
=============

New features
------------ Metadefender now uses Metascan workflows (Metascan versions 3.10.1 and later)
- Custom authentication modules are supported
- Windows 10 support

Other changes
------------- None

Version 3.1.0
=============

New features
------------
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- Metascan functionality can now be configured within the Metadefender Management Console.
This is only supported for Metascan servers version 3.9.5 or later.
- Support for floppy disks as the copy destination in post-actions

Other changes
------------- Custom time periods can be set for the statistics displayed on the Metadefender dashboard

Version 3.0.12
=============

New features
------------ Upload to Policy Patrol Secure File Transfer (Requires version 2.2 or later of SFT) is now
available as a post action
- The Metadefender Management Console has an updated look and feel, matching the
Metascan Management Console

Other changes
------------- The security and compatibility of the Metadefender Management Console has been improved
by replacing the PHP component with JavaScript
- Stability of the data sanitization post-action has been improved
- Fixed issue where floppy disk drives on non-English operating systems were not being
recognized
- Fixed issue where in certain circumstances Metadefender might not start automatically upon
system restart

Version 3.0.11
=============

New features
------------ None
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Other changes
------------- Updated kiosk UI strings for non-English languages
- Improved support of Ironkey D250 encrypted USBs
- Improved support for Kanguru Elite Defender 30 USBs
- Improved support for Kingston encrypted USBs
- If Windows authentication is enabled, non-local (i.e. domain) users are now required to
specify their domain

Version 3.0.10
=============

New features
------------ None

Other changes
------------- Resolved issue where files would fail to copy to network locations when SHA-256 hash
verification was enabled
- Resolved issue in displaying large number of files in Metadefender's browse dialog
- Support for file type conversion from image files has been removed. Conversion from PDF is
now only supported to sanitized PDF. For customers that will be exporting Metadefender
workflows that used this functionality OPSWAT recommends that these conversions are
disabled before exporting.

Version 3.0.9
=============

New features
------------ None
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Other changes
------------- Reduced the latency in loading workflow configuration when there are many user accounts on
the associated active directory server
- Resolved race condition where Metadefender occasionally did not start upon system startup
when installed on Windows 8 or newer operating systems
- Improved behavior when multiple instances of Metadefender are running on the same system

Version 3.0.8
=============

New features
------------ Windows 8.1 and 2012 R2 are now supported
- Buffalo RUF2-hsc-2gt Encrypted USBs are now supported
- McAfee Complete Data Protection Encrypted USBs are now supported
- EncryptDisc media is now supported
- Kanguru Defender Elite 30 USB devices are now supported
- Metadefender Idle Screen can be customized
- German and Korean translations of the Metadefender kiosk UI

Other changes
------------- Hashes of files are re-verified when the 'Copy To' post action command is used
- Better handling of network failures when scanning with a remote Metascan server

Version 3.0.7
=============

New features
------------ Scan logs can be saved to the media being scanned
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- Recent sessions now listed in the Metadefender Management Console logs page
- Support for Buffalo SecureLock encrypted devices
- Receipt can be configured to print automatically

Other changes
------------- More details available in the scan result screen for files that failed to scan
- Kiosk user can be alerted when Metadefender license is close to expiration
- New HTML documentation available through the Management Console
- Romaji input supported on Japanese keyboard
- More robust support for Kingston DataTraveler encrypted USBs
- Bitlocker encrypted drives are now supported on Windows 8.1
- Other minor changes

Version 3.0.6
=============

New features
------------ Support for Ironkey D250 encrypted USBs
- Support for BitLocker (password) encrypted devices
- Vietnamese and Japanese user interface available by default

Other changes
------------- User account credentials used for post actions when Windows authentication is enabled
- Better indication when potential threats are found
- Additional scan result details included in text log file
- Debug log package available for download in Management Console
- Additional printout configuration options
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Version 3.0.5
=============

New features
------------ Added Support of KIOSK UI localization
- Added predefined KIOSK UI Localization for Hebrew & Arabic
- Added additional predefined profiles
- More configuration for printouts

Other changes
------------- Fixed error when scanning empty media
- Improved accuracy of timestamps in logs
- Improved error handling and logging for errors
- Updated logs to include scan failure reason.
- Clearer notification when a threat is found
- Add ability to set password in Metadefender Management Console
- Various bug fixes.

Version 3.0.4
=============

New features
------------ Copy to user provided media as post-action
- Username is available as a variable in post-actions when Windows login is enabled

Other changes
------------- Improved archive handling
- Improved physical keyboard support
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- Scan is aborted if connection with Metascan server is interrupted (when Metascan is on
separate machine)
- Improved handling when Metascan server is operating at maximum capacity
- Fixed potential issue where Metadefender failed to launch due to latency of Windows desktop
preparation
- Better logging for interruptions during post processing
- Minor bug fixes
- UI improvements

Version 3.0.3
=============

New features
------------ None

Other changes
------------- Fixed print formatting issues

Version 3.0.2
=============

New features
----------------- Search for processing result by file upload
- Ability to export processing logs
- Allow search results to be bookmarked for later reference
- Display more detailed progress during file enumeration
- Improved Metadefender Management Console
- Improved formatting for built-in kiosk printers
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Other changes
------------- Fixed bug that was preventing restoration of default and guest profiles
- Prevent users from being added to more than one workflow profile

Version 3.0.1
=============

New features
----------------- User Authentication
- Customizable User Profiles
- Configurable User Questions
- Filtering by File Type
- Web-Based Metadefender Management Console
- System Restore with Deep Freeze
- File Type Conversions
- Enhanced Post-Processing Options
- New End User Workflow
- Option to Restart After Each Session
- Comprehensive Logging for all Processed Files
- Support for Kingston encrypted USB drives
- Handling USB with partially corrupted file system

12.2. Known Limitations of Metadefender Kiosk
Upgrading from 2.x
All configuration is now DB-based. For migration, please contact OPSWAT.
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Handling Multiple Devices
Metadefender Kiosk does not allow multiple devices to be processed at the same time. Each
device must be inserted independently.

Non-Windows Partitions
Metadefender Kiosk does not support scanning partitions that cannot be mounted to volumes in
Windows (e.g. Linux/Android/Mac). However, many anti-malware engines incorporate virus
definitions for all operating systems, regardless of the system on which the engine will be
installed. OPSWAT tests indicate that for each non-windows threat sample, a large number of
antivirus engines detected that the file is infected.

USB Hubs
If a USB hub with multiple USB drives is inserted into a Metadefender Kiosk system for
scanning, Metadefender Kiosk will only scan the first device reported to Windows. This is not
guaranteed to be the same device each time the USB hub is inserted. OPSWAT does not
recommend connecting drives to Metadefender Kiosk through a USB hub.

Self-Extracting Archives
The only self-extracting archives that are fully supported to be scanned as archives are ones
created by 7-zip and WinRAR. Self-extracting archives created using other technologies may
be recognized and scanned as archives but OPSWAT does not guarantee that this will be
possible.

Private or encrypted partitions
If a device has a private, or encrypted partition, Metadefender Kiosk may not be able to read it.
Encrypted drives can be scanned as described in 9.3. Unlocking Encrypted Devices. Nonprimary encrypted partitions can be blocked in the Metadefender Kiosk Management Console.
If a drive does not have any readable partitions, you can use Metadefender Kiosk’s Wipe
functionality to clean the drive and ensure that there are no hidden partitions. Refer to the
Advanced Options section of 7.3. Configuring User Settings for additional information.

UAC
If UAC is not disabled Metadefender Kiosk's watchdog functionality may not work correctly.

4.1.0

155

Other Known Issues
All external USB drives, such as SD card readers, floppy disk drives, and CD ROM
drives, must be inserted before Metadefender Kiosk is started.
Windows User Accounts (domain or local) can be assigned to multiple workflow profiles
and only one of the profiles will be used.
For certain encrypted devices (e.g. Kanguru, Ironkey and Kingston), unlocking may fail
even with the correct password if a user interacts with the Kiosk UI during the process of
unlocking.
McAfee & BitLocker encrypted drives are not supported for the wipe functionality.
Downgrading from 4.1.x will require to reactivate the license.
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13. Legal
Copyright
Export Classification EAR99

Copyright
DISCLAIMER OF WARRANTY
OPSWAT Inc. makes no representation or warranties, either express or implied by or with
respect to anything in this document, and shall not be liable for any implied warranties of
merchantability or fitness for a particular purpose or for any indirect special or consequential
damages.

COPYRIGHT NOTICE
OPSWAT, OESIS, Metascan, Metadefender, AppRemover and the OPSWAT logo are
trademarks and registered trademarks of OPSWAT, Inc. All other trademarks, trade names and
images mentioned and/or used herein belong to their respective owners.
No part of this publication may be reproduced, stored in a retrieval system or transmitted, in
any form or by any means (photocopying, recording or otherwise) without prior written consent
of OPSWAT Inc. No patent liability is assumed with respect to the use of the information
contained herein. While every precaution has been taken in the preparation of this publication,
OPSWAT Inc. assumes no responsibility for errors or omissions. This publication and features
described herein are subject to change without notice.

Export Classification EAR99
EAR99 (Export Administration Regulation 99) is an export classification category regulated by
the U.S. Department of Commerce that covers most commercial items exported out of the U.S.
OPSWAT’s software is designated as EAR99, and there are no export restrictions other than
embargoed countries and persons.
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14. Knowledge Base Articles
Page: How does Metadefender Kiosk do file type detection?
Page: Why did Metadefender Kiosk stop working on Windows 10 ?
Page: Why doesn't Metadefender Kiosk start?
Page: Can a Syslog event be generated when an infection is found?
Page: Can I add groups from Active Directory to Metadefender Kiosk workflow profiles?
Page: Can Metadefender Kiosk be configured to handle larger volumes of scans more
quickly?
Page: Can I upload files to a file server after they have been scanned by Metadefender
Kiosk?
Page: How can Metadefender Kiosk and SFT be configured to work with an Arbit Data
Diode?
Page: Can I extend Metadefender Kiosk with custom engines or signatures?
Page: Can I run Metadefender Kiosk using a non-administrator account?
Page: Can I run Metadefender Kiosk without IIS?
Page: How do I save files to a mapped drive with Metadefender Kiosk?
Page: What is a sanitized file - Kiosk?
Page: What kind of media can Metadefender Kiosk scan?
Page: What are the running processes of Metadefender Kiosk?
Page: How do I set the Restart Metadefender option for Metadefender Kiosk Watchdog
on Windows 8 and above?
Page: How long is the support life cycle for a specific version/release of Metadefender
Kiosk?
Page: Why are some of the keys on the physical keyboard not responsive in
Metadefender Kiosk?
Page: What is the difference between the Format, 1-pass, 3-pass, and 7-pass options in
the Metadefender Kiosk wipe functionality?
Page: Where can I find FAQs about Metadefender Kiosk's antivirus signature updates?
Page: Why is Metadefender Kiosk not recognizing floppy drives?
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Can a Syslog event be generated when an infection is found?
Yes, a Syslog event can be generated when an infection is found. Please note that this feature
is only for files scanned through REST API and events generated in REST layer.
In order to configure Syslog events, open your Metadefender Kiosk management console (the
default is localhost:8009) and navigate to Logs > Configuration.
Here you can set your preferences for Syslog events.

This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-30
CN

Can I add groups from Active Directory to Metadefender Kiosk
workflow profiles?
No. You can add users from Active Directory or Windows local account to Metadefender Kiosk
workflow profiles, but not groups. Multiple users can be added from the Properties &
Membership page by selecting members in the Workflows page. To do so, press Shift while
selecting users and then click Add.
4.1.0

159

This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-30
RR

Can I extend Metadefender Kiosk with custom engines or signatures?
In Metadefender Kiosk, you can extend the scanning capabilities by adding custom engines to
the Metadefender Core instance Metadefender Kiosk is configured to use to scan files. The
custom engines can perform malware scanning or other types of file scanning such as sensitive
data analysis or DLP engine. For more information on implementing and using custom engines,
please refer to the Metadefender Core documentation.

This article applies to Metadefender Kiosk product
This article was last updated on 2016-09-13
CA

Can I run Metadefender Kiosk using a non-administrator account?
No, it is not possible to run Metadefender Kiosk using a limited-privilege account. Some core
Metadefender Kiosk functionality requires admin access to the host OS, and this is not
expected to change in future versions.
To preserve the integrity of your Kiosk environment, you are encouraged to follow the steps
outlined in the Metadefender Kiosk Documentation.
This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-30
CN

Can I run Metadefender Kiosk without IIS?
IIS is one of the required components for Metadefender Kiosk to function as it is intended. You
may uninstall IIS if you wish, and Metadefender Kiosk will still retain the local scan functionality.
However, we do not recommend doing this. OPSWAT does not support Metadefender Kiosk
with IIS removed.
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IIS is a necessary component of Metadefender Core REST which is responsible for the REST
API and other components which require REST service to be operational, including remote
scanning, generation and scanning via Metadefender Client, and configuring or activating your
Metadefender Core via Management Console.

This article applies to Metadefender Kiosk product.
This article was last updated on 2016-08-16.
CN

Can I upload files to a file server after they have been scanned by
Metadefender Kiosk?
There are multiple ways that files can be moved to a file server after they have been scanned
by Metadefender Kiosk. All of these options can be configured as part of Metadefender Kiosk
workflows
1. Files can be uploaded to a Metadefender Secure File Transfer (SFT) server using the

built in integration in Metadefender Kiosk.
2. Files can be copied to a network path
3. Files can be uploaded to a file server using a custom script

For more information on each of these methods, please consult the Metadefender Kiosk
documentation.

This article pertains to Metadefender Kiosk
This article was last updated on 2016-09-02
PM

Can Metadefender Kiosk be configured to handle larger volumes of
scans more quickly?
Metadefender Core may limit the performance of a kiosk solution. Metadefender Core's
performance is greatly affected by host hardware specifications. Due to space and airflow
limitations, the computers in kiosks are small and therefore not optimal for heavy Metadefender
usage.
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Customers that require high volume scans and faster performance should consider a
distributed configuration where the Metadefender Kiosk module is maintained on the Kiosk and
the Metadefender Core module is maintained on a powerful remote server.
The diagram below illustrates the distributed configuration:

This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-30
RR

How can Metadefender Kiosk and SFT be configured to work with an
Arbit Data Diode?
This article describes how to deploy Metadefender Kiosk, an Arbit data diode, and a
Metadefender SFT server for the following use case:
1. Portable media is scanned by Metadefender Kiosk.
2. Clean files are passed through an Arbit data diode to an SFT server.
3. User downloads files from the SFT server.

System Deployment
Do the following before configuring the individual systems.
1. Install Metadefender Kiosk with Metadefender Core on the low side network.
2. Install the Arbit data diode with the receiving side in the low side network and the

transmitting side on the high side network.
a.
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2.

a. Assign a static IP address to the low side.
b. Assign a static IP address to the high side.
3. Install the SFT server on the high side network.
a. Assign a static IP address.

SFT Server Configuration
1. Create the user accounts on the SFT server.
a. Note the account that should be used as the 'from' account for files coming from

Metadefender Kiosk.
2. Generate the authorization token.

Arbit Data Diode Configuration
1. Define the URL list on the high side of the data diode to include the SFT server.
a. URL list includes http://<SFT IP Address>:8000/sft_rest/file

Metadefender Configuration
1. Configure the appropriate Metadefender Kiosk workflow profile to enable Copy To SFT in

the post-action.
2. Put in the URL of the data diode low-side receiver.
a. http://<diode low-side IP address>:8080/pitcherrestapi/transfer/<URL List>
3. Enter the authorization token generated by the SFT server.
4. Enter the Sender SFT account that was created on the SFT server.

This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-30
RR

How does Metadefender Kiosk do file type detection?
Metadefender Kiosk does file type detection (also referred to as 'file type analysis', 'file type
mismatch', 'file mismatch analysis', etc.) through it's integration with Metadefender Core. To
enable file type detection in Metadefender Kiosk, specify the usage of a Metadefender Core
workflow that has enabled file type detection.
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For more information on how Metadefender Core does file type detection please read this
knowledge base article .

This article pertains to Metadefender Kiosk
This article was last updated on 2016-09-12
CA

How do I save files to a mapped drive with Metadefender Kiosk?
In order to save files to a mapped drive from Metadefender Kiosk, the mapped drive must be
created under the SYSTEM account.
To do this, please follow the directions below:
1. Place the psexec.exe tool on the machine where you want the mapped drive to be

created (e.g., C:\Sysinternals\psexec.exe).
Note: You can download the psexec.exe file from the Sysinternals Security Utilities suite
at http://technet.microsoft.com/en-us/sysinternals/bb795534.
2. Go to the command prompt icon, right-click and select “Run as Administrator”.
3. In the command prompt, go to the directory where psexec.exe was copied (e.g., "cd C:

\Sysinternals").
4. Enter the following command to open a command prompt as the SYSTEM user: “psexec.

exe –i –s cmd.exe”
5. In the new command prompt window that just opened, enter the following command:

“whoami"
6. Confirm that the current command prompt is running as “nt authority\system”.

7.
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7. Execute the following command to mount the mapped drive: net use <desired drive

letter> <UNC path to map to> (e.g., “net use Z: \\file-server-1\share”).
8. Once the mapped drive is in place, go to the Metadefender Kiosk Management

Workflows page: http://localhost:8009/management/#/workflows.
9. Choose the profile you want to change.
10. In the File Handling section select the Copy to radio button and enter the mapped

location.

11. Click Finish. Metadefender Kiosk can now copy both Blocked and Allowed files to the

network drive.

4.1.0

165

This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-30
RR

How do I set the Restart Metadefender option for Metadefender Kiosk
Watchdog on Windows 8 and above?
The following information is for users who would like to set the Metadefender Kiosk Watchdog
to the "Restart Metadefender" option when running on Windows 8 or above.
In order for the Watchdog to be able to restart the Metadefender Kiosk UI automatically, you
will need to fully disable User Account Control (UAC) in the Windows OS. This is because in
Windows 8 and above Microsoft has made the process of launching an interactive process from
a service extremely difficult due to the security holes this could potentially open up. The most
effective way to disable UAC is to make a change to a registry value:
1. Open regedit.exe.
2. Open the registry key at

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System
then find the EnableLUA registry value.
3. Set EnableLUA to 0.
4. Restart Windows.

Alternatively, you can adjust your Local Group Policy settings to disable UAC. You can only
access the Group Policy editor if you have the Professional, Enterprise, or Ultimate edition of
the Windows OS.
1. Click Start and type "gpedit.msc" to open the Group Policy Editor.
2. Navigate to Computer Configuration > Windows Settings > Local Policies > Security

Options.
3. After clicking Security Options, the right panel populates with your policies. Locate the

ones for User Access Control.
4. Set Run all administrators in Admin Approval Mode to "Only elevate executables that

are signed and validated."
5. Set Switch to the secure desktop when prompting for elevation to "Disabled"
6. Restart Windows.

Note:
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The steps described above will completely disable UAC on this machine. Please
check with your system administrators before disabling this important Windows
security feature.
Related articles :
http://winaero.com/blog/how-to-turn-off-and-disable-uac-in-windows-10/
http://www.computerperformance.co.uk/win8/windows8-uac-disable.htm

This article pertains to Metadefender Kiosk product
This article was last updated on 2016-09-02
CN

How do I set Watchdog for Windows 8 and above?
OPSWAT recommends that user access control (UAC) is disabled on systems that are being
used as dedicated Metadefender Kiosks. If UAC is not disabled, Metadefender Kiosk's print
functionality may not work correctly. Metadefender Kiosk's watchdog functionality will also not
work correctly if UAC is not disabled.
The following information is for users who would like to set the Metadefender Watchdog to the
"Restart Metadefender" option when running on Windows 8 and above.
In order for the Watchdog to be able to restart the Metadefender UI automatically, you must
fully disable User Account Control (UAC) in the Windows OS. For Windows 8 and above,
Microsoft has made the process of launching an interactive process from a service extremely
difficult due to the security holes this could potentially open up. The most effective way to
disable UAC is to make a change to a registry value:
1. Open regedit.exe.
2. Open up the registry key at

"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System"
and locate the EnableLUA registry value.
3. Set EnableLUA to 0
4. Restart Windows.

Alternatively, you can adjust your Local Group Policy settings to disable UAC. You can only
access the Group Policy editor if you have the Professional, Enterprise, or Ultimate edition of
the Windows OS.
1. Click Start and enter gpedit.msc to open the Group Policy Editor.

2.

4.1.0

167

2. Navigate to Computer Configuration > Windows Settings > Local Policies > Security

Options.
3. After clicking Security Options, the right pane populates with your policies. Locate the

ones for User Access Control.
a. Set Run all administrators in Admin Approval Mode to "Only elevate executables

that are signed and validated."
b. Set Switch to the secure desktop when prompting for elevation to "Disabled."
4. Restart Windows.

Note: The steps described above will completely disable UAC on this machine.
Please check with your system administrators before disabling this important Windows
security feature.
Related articles
http://winaero.com/blog/how-to-turn-off-and-disable-uac-in-windows-10/
http://www.computerperformance.co.uk/win8/windows8-uac-disable.htm
This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-25
EF

How long is the support life cycle for a specific version/release of
Metadefender Kiosk?
OPSWAT provides support on each release of Metadefender Kiosk for 18 months after the
publication of the next release of the product (i.e. once a new release is published, you have 18
more months of support on the previous release). However, bug fixes and enhancements are
applied only to the upcoming releases of a product, not to the current release or historical
releases, even when those releases are still under support. In some cases hot-fixes can be
provided for the current release of the product, and then incorporated as a regular fix in the
next release.
OPSWAT strongly encourages customers to upgrade to the latest release on a regular basis
and not to wait until the end of a releases supported life-cycle.
Note that prior to release 3.3.0, Metadefender Kiosk was called Metadefender. The name
change does not affect the support life cycle of any of the releases, regardless of which name
they were released under.
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The 3.4.5 release was the last release with new functionality on the Metadefender Kiosk v3
platform. Any 3.4.x release after 3.4.5 will be a patch release and will only be supported
through the 3.4.5 EOL date (5 Jan 2019).
All releases older than 3.3.0 are no longer supported.
Release number

Release date

4.0.1

31 Jul 2017

4.0.0

5 Jul 2017

31 Jan 2019

3.4.6

25 Jul 2017

5 Jan 2019

3.4.5

25 Apr 2017

5 Jan 2019

3.4.4

15 Mar 2017

25 Oct 2018

3.4.3

08 Feb 2017

15 Sep 2018

3.4.2

13 Dec 2016

08 Aug 2018

3.4.1

10 Nov 2016

13 Jun 2018

3.4.0

08 Nov 2016

10 May 2018

3.3.6

30 Sep 2016

08 May 2018

3.3.5

01 Sep 2016

30 Mar 2018

3.3.4

12 July 2016

01 Mar 2018

3.3.3

02 Jun 2016

12 Jan 2018

3.3.2

20 Apr 2016

02 Dec 2017

3.3.1

15 Mar 2016

20 Oct 2017

3.3.0

10 Feb 2016

15 Sep 2017
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3.2.0

23 Dec 2015

10 Aug 2017

3.1.0

29 Oct 2015

23 Jun 2017

3.0.12

2 Oct 2015

29 Apr 2017

This article pertains to all supported releases of Metadefender Kiosk (formerly called
Metadefender).
This article was last updated on 2017-08-11
TV

What are the running processes of Metadefender Kiosk?
The running processes of Metadefender Kiosk are as follows:
Metadefender Custom Authentication Handler
Metadefender Service
Metadefender WatchDog
Metascan DB Controller
Metascan REST Service
Metascan Post Action Center
mongod

This article pertains to Metadefender Kiosk
This article was last updated on 2017-03-10
HN

What is a sanitized file - Kiosk?
A sanitized file is a file which has been gone through a process to strip any embedded objects
and exploits while preserving the usability of a file. The sanitized will still have the format and
file extension of the original file (unless its been explicitly set up to be converted to another type
of file). For example, a sanitized PDF will still contain the PDF format, contain the .PDF
extension, and be accessible by a PDF reader
Some of the actions performed as part of santization can include:
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Removing all attachments and document action
Removing all annotations
Removing java script
Making the form fields present in PDF file un-editable/in-accessible so that the user
cannot update the values
Removing hyperlinks
Recent versions of Metadefender Kiosk allow administrators to create sanitization processes as
part of the file type conversion process. For more information refer to the user manual:
For Metadefender Kiosk read about it in the Online Metadefender Kiosk Documentation
at Kiosk Authentification / User -> Selecting How to Handle Processed Files
Metadefender Kiosk supports file type sanitization for many of the most common types of
document files. If you have a request for a file type that we do not support, log a ticket with us
on the OPSWAT portal to let us know. Though we cannot make any commitments as to when
we will add support, we are always looking to add new file types that are commonly used by our
customers.
This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-31.
CA

What is the difference between the Format, 1-pass, 3-pass, and 7pass options in the Metadefender Kiosk wipe functionality?
All of these options delete all of the files on the selected media. However, some of the methods
are more secure because they make it harder for data to be recovered using specialized tools
that can read the remnants of files that were previously on the disk.
Format is the fastest option, but it simply removes the references to the files on the drive
without overwriting those portions of the drive. The 1, 3, and 7 pass wipe options write over the
entire drive with random data, making it much more difficult to retrieve the data that was
originally stored on the drive. The only way to fully erase the hard drive is to write over it using
the wipe feature. The 1, 3 or 7 option lets you choose how many passes you wish to do. The
United States Department of Defense recommends using a 7 pass wipe to clean media. To do
the wiping, we use a third party library called Eraser.
If a device has a private or encrypted partition, systems may not be able to read it. Non-primary
encrypted partitions can be blocked in the Metadefender Kiosk Management Console. If a drive
does not have any readable partitions, we recommend using the wipe functionality to clean the
drive and ensure that there are no hidden partitions.
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This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-30
RR

What kind of media can Metadefender Kiosk scan?
Metadefender Kiosk can scan most Microsoft file system compatible media, including:
USB devices
CDs/DVDs/Blu-ray
Card readers
SD cards
Floppy disks
Note: Metadefender Kiosk only supports scanning partitions that can be mounted to volumes in
Windows (e.g., Linux/Android/Mac).
Metadefender Kiosk supports the following encrypted USB drives:
IronKey S200
IronKey D250
SanDisk Cruzer Enterprise FIPS Edition
SanDisk Cruzer Contour
U3 based USBs
Buffalo RUF2-HSCT and RUF3-HSL
Kingston DataTraveler Vault Privacy
Kanguru Defender Elite 30
Kanguru 2000
Kanguru 3000
Microsoft BitLocker
We support BitLocker To Go using passwords
We do not support BitLocker encryption using key files or smart cards
We do not support VHD (Virtual Hard Drive) BitLocker encryptions
McAfee Complete Data Protection
When McAfee File and Removeable Media Protection client is installed
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This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-05
CA

Where can I find FAQs about Metadefender Kiosk's antivirus
signature updates?
Metadefender Kiosk relies on its underlying Metadefender Core server to manage antivirus
signature updates. You can find FAQs on this topic by searching on "antivirus signature
updates" in the Metadefender Core V3 section of the knowledge base.
This article pertains to Metadefender Kiosk
This article was last updated on 2016-07-27
CN

Why are some of the keys on the physical keyboard not responsive in
Metadefender Kiosk?
Metadefender Kiosk has a security requirement that the application be the only accessible item
on the computer for non-administrator users.
As part of this security requirement, the system ignores certain keys on the keyboard that in
Windows can be used in combination with other keys to close an application, access the
desktop, access other programs, etc.
We have had requests from some customers to enable these keys and our product team is
researching ways to meet the security requirement while still providing the convenience of
using the critical keys on the keyboard.
This article pertains to Metadefender Kiosk
This article was last updated on 2016-08-04
EF

Why did Metadefender Kiosk stop working on Windows 10 ?
If you are using Windows 10 and applied the Anniversary Update, your REST service will stop
functioning.
To fix this issue, please follow the steps below :
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1. Open an elevated Command Prompt by clicking Start, typing cmd in the search bar, rightclicking the command prompt and selecting run as administrator
2. Type net stop omdrest
3. Uninstall IIS Express 8.0
4. Install IIS express 8.0 again. If you need any guidance for installing IIS express 8.0., please
check https://www.microsoft.com/en-us/download/details.aspx?id=34679
5. Type net start omdrest
For more information about the update, please check the related Microsoft page.
This article pertains to Metadefender Kiosk
This article was last updated on 2016-11-08
CN

Why doesn't Metadefender Kiosk start?
If Metadefender Kiosk doesn't start and you see the dialog below, it may be because the
machine hosting Metadefender Kiosk is too slow. (This can be for a number underlying of
reasons, including underpowered CPU, not enough RAM, or show hard disk speeds).

To fix this issue, create and update the string registry key launch_delay_seconds in
"HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\OPSWAT\MD4M" and set this to any
value greater than zero.
To set this registry key open the regedit utility and follow the steps below:
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Navigate to "HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\OPSWAT\MD4M"

Right click and choose New -> String Value

Name the new value launch_delay_seconds
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Double click the newly assigned String and assign it a value of 60 seconds

Restart Metadefender Kiosk and Metadefender Kiosk Rest service by opening an elevated
command prompt and type the following commands:
net stop metadefenderSVC
net stop omdrest
net start omdrest
net start metadefenderSVC
If following these steps still do not resolve your problem, please log a ticket with OPSWAT
Support
This article pertains to Metadefender Kiosk
This article was last updated on 2017-01-04
CN
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Why is Metadefender Kiosk not recognizing floppy drives?
By default, Metadefender Kiosk has floppy drive access disabled under workflow configuration.
You can re-enable this under the Metadefender Kiosk Management Console by going to
Workflows > Media Types and selecting the Floppy checkbox. Then click Apply.

This article applies to Metadefender Kiosk
This article was last updated on 2016-08-12
EF
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